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PREFACE 
 
This manual explains how to use the Horner Wi-Fi, HE-WIFIUSB. 
 
Copyright© 2020 Horner APG, LLC, 59 South State Avenue, Indianapolis, Indiana 46201. All 
rights reserved. No part of this publication may be reproduced, transmitted, transcribed, 
stored in a retrieval system, or translated into any language or computer language, in any 
form by any means, electronic, mechanical, magnetic, optical, chemical, manual or otherwise, 
without the prior agreement and written permission of Horner APG, Inc. 
 
All software described in this document or media is also copyrighted material subject to the 
terms and conditions of the Horner Software License Agreement. 
 
Information in this document is subject to change without notice and does not represent a 
commitment on the part of Horner APG. 
 
Ethernet™ is a trademark of Xerox Corporation. 
microSD™ and CompactFlash are registered trademarks of SanDisk Corporation. 
 
 
For user manual updates, contact Technical Support:  
 
North America:  
Tel: (+) (317) 916-4274 
Fax: (+) (317) 639-4279 
Website: https://hornerautomation.com 
Email: techsppt@heapg.com 
 
 
Europe:  
Tel: (+) 353-21-4321-266 
Fax: (+) 353-21-4321-826 
Website: http://www.hornerautomation.eu 
Email: technical.support@horner-apg.com 
 

https://hornerautomation.com/
mailto:techsppt@heapg.com
http://www.hornerautomation.eu/
mailto:technical.support@horner-apg.com
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LIMITED WARRANTY AND LIMITATION OF LIABILITY 
 

Horner APG, LLC, ("HE-APG") warrants to the original purchaser that the HE-WIFIUSB module 
manufactured by HE-APG is free from defects in material and workmanship under normal use 
and service.  The obligation of HE-APG under this warranty shall be limited to the repair or 
exchange of any part or parts which may prove defective under normal use and service within 
two (2) years from the date of manufacture or eighteen (18) months from the date of installation 
by the original purchaser whichever occurs first, such defect to be disclosed to the satisfaction 
of HE-APG after examination by HE-APG of the allegedly defective part or parts. THIS 
WARRANTY IS EXPRESSLY IN LIEU OF ALL OTHER WARRANTIES EXPRESSED OR IMPLIED 
INCLUDING THE WARRANTIES OF MERCHANTABILITY AND FITNESS FOR USE AND OF ALL 
OTHER OBLIGATIONS OR LIABILITIES AND HE-APG NEITHER ASSUMES, NOR AUTHORIZES 
ANY OTHER PERSON TO ASSUME FOR HE-APG, ANY OTHER LIABILITY IN CONNECTION WITH 
THE SALE OF THIS HE-WIFIUSB MODULE. THIS WARRANTY SHALL NOT APPLY TO THIS HE-
WIFIUSB MODULE OR ANY PART THEREOF WHICH HAS BEEN SUBJECT TO ACCIDENT, 
NEGLIGENCE, ALTERATION, ABUSE, OR MISUSE. HE-APG MAKES NO WARRANTY 
WHATSOEVER IN RESPECT TO ACCESSORIES OR PARTS NOT SUPPLIED BY HE-APG. THE 
TERM "ORIGINAL PURCHASER", AS USED IN THIS WARRANTY, SHALL BE DEEMED TO MEAN 
THAT PERSON FOR WHOM THE HE-WIFIUSB MODULE IS ORIGINALLY INSTALLED. THIS 
WARRANTY SHALL APPLY ONLY WITHIN THE BOUNDARIES OF THE CONTINENTAL UNITED 
STATES. 
 
In no event, whether as a result of breach of contract, warranty, tort (including negligence) or 
otherwise, shall HE-APG or its suppliers be liable of any special, consequential, incidental or 
penal damages including, but not limited to, loss of profit or revenues, loss of use of the 
products or any associated equipment, damage to associated equipment, cost of capital, cost 
of substitute products, facilities, services or replacement power, down time costs, or claims of 
original purchaser's customers for such damages. 
 
To obtain warranty service, return the product to your distributor with a description of the 
problem, proof of purchase, postpaid, insured and in a suitable package. 
 
 

ABOUT PROGRAMMING EXAMPLES 
 

Any example programs and program segments in this manual or provided on accompanying 
diskettes are included solely for illustrative purposes. Due to the many variables and 
requirements associated with any installation, Horner APG cannot assume responsibility or 
liability for actual use based on the examples and diagrams. It is the sole responsibility of the 
system designer utilizing the HE-WIFIUSB module to appropriately design the end system, to 
appropriately integrate the HE-WIFIUSB module and to make safety provisions for the end 
equipment as is usual and customary in industrial applications as defined in any codes or 
standards which apply. 
 
NOTE: The programming examples shown in this manual are for illustrative purposes only. 

Proper machine operation is the sole responsibility of the system integrator. 
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CHAPTER 1: SAFETY / COMPLIANCE 
 

1.1 Safety Warnings and Guidelines 
When found on the product, the following symbols specify:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
a. All applicable codes and standards need to be followed in the installation of this product. 
b. For I/O wiring (discrete), use the following wire type or equivalent: Belden 9918, 18 AWG 

or larger.  
  

Warning: Consult user documentation. Warning: Electrical Shock Hazard. 

WARNING – EXPLOSION HAZARD – Do not disconnect equipment unless power has been 
switched off or the area is known to be non-hazardous 
 
WARNING: To avoid the risk of electric shock or burns, always connect the safety (or 
earth) ground before making any other connections.  
 
WARNING: To reduce the risk of fire, electrical shock, or physical injury it is strongly 
recommended to fuse the voltage measurement inputs. Be sure to locate fuses as close to 
the source as possible. 
 
WARNING: Replace fuse with the same type and rating to provide protection against risk 
of fire and shock hazards.   
 
WARNING: In the event of repeated failure, do not replace the fuse again as a repeated 
failure indicates a defective condition that will not clear by replacing the fuse.  
 
WARNING – EXPLOSION HAZARD: Substitution of components may impair suitability for 
Class I, Division 2 
 
 



  MAN1234-03-EN_HE-WIFIUSB _UM 

D e c e m b e r  1 ,  2 0 2 0      P a g e  7 | 121 
 

Adhere to the following safety precautions whenever any type of connection is made to the 
module.  
 

a. Connect the green safety (earth) ground first before making any other connections.  
b. When connecting to electric circuits or pulse-initiating equipment, open their related 

breakers. Do not make connections to live power lines.    
c. Make connections to the module first; then connect to the circuit to be monitored.  
d. Route power wires in a safe manner in accordance with good practice and local codes. 
e. Wear proper personal protective equipment including safety glasses and insulated 

gloves when making connections to power circuits.  
f. Ensure hands, shoes, and floors are dry before making any connection to a power line.  
g. Make sure the unit is turned OFF before making connection to terminals. Make sure all 

circuits are de-energized before making connections.  
h. Before each use, inspect all cables for breaks or cracks in the insulation. Replace 

immediately if defective. 
 

 

1.2 Compliance  
 
To check for compliance and updates, visit the Horner website.  
North America: https://hornerautomation.com or Europe: http://www.hornerautomation.eu 
 
  

https://hornerautomation.com/
http://www.hornerautomation.eu/
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CHAPTER 2: INTRODUCTION 
 

2.1 Overview of the Horner Wi-Fi, HE-WIFIUSB 
   
The Horner Wi-Fi module provides both client and access point support to OCS units that 
support USB Host connections. USB Wi-Fi is supported in XL4e, XL7e, EXL10e, EXL6e, EXLW, 
RCC2414, X5 and XL+ models. As an access point, OCS allows other Wi-Fi devices to connect 
to a wired network.  Using client mode, the OCS can connect to an established Wi-Fi network. 
As an Access point or client mode user can connect laptops for programming or phones and 
tablets for WebMI and Ethernet protocols supported by the OCS, excluding NTP and Ethernet 
IP Protocols can be accessed via Wi-Fi connectivity. 
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2.1.1    Where to Find Information about the HE-WIFIUSB 
 

1.  Datasheet - The datasheet is the first document to refer to for key information: 
a. The sensor datasheet, MAN1233, on the Horner websites. 
b. Datasheet contains more specific information.  

 
2.  User Manual -This manual provides general information that is common to HE-WIFIUSB 

and can be downloaded from our websites. Visit the Horner website to obtain user 
documentation and updates.  North America: https://hornerautomation.com or  
Europe: http://www.hornerautomation.eu  

 
 
2.1.2    Three main types of information are covered in this manual 

a) Safety and Installation guidelines / instructions (Mechanical) 
b) Description of hardware features  
c) Types of Configuration 
d) Support 

 
 
 

 
 
  

https://hornerautomation.com/
http://www.hornerautomation.eu/
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CHAPTER 3: HE-WIFIUSB DIMENSIONS & 
INSTALLATION 
 

3.1  Mounting 
 
The Horner HE-WIFIUSB unit requires a Horner Automation OCS with USB 2.0 HOST Support.  
Plug in Horner HE-WIFIUSB and then set up communications using Communications Chapter.  
 
 
 
 
 
 
 
             
 
 
          
         
           
 
 
 

         
Thread: 3/4 NPT Pipze Size, 14 threads per inch, .055” Threads Engagement 
 
 
 
 
 
 
 
 
 
 
 
 
 

Panel Cutout Dimensions: 27.67mm (1.05”)  
Tolerance: +0.0005” 
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3.2 Dimensions  
 
Thread: 3/4 NPT Pipze Size, 14 threads per inch, .055” Threads Engagement 

 

 

 

 
 
 
 
 
NOTE:  The Wi-Fi unit is designed to be mounted outside the panel for best range. Mounting 
inside metal cabinets will significantly reduce the range of this product. 
 
Remove power from the OCS, plug the Wi-Fi unit into the OCS USB port and reapply power.  
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3.3 Installation Instructions 
 
NOTE:  HE-WIFIUSB unit is designed to be mounted outside the panel box. Mounting inside metal 
cabinets will significantly reduce the range of this product.   
 
1) Ensure your controller is updated to the most recent version of firmware dependent on its version. 
2) Turn off the controller. 
3) Drill a hole in the panel box housing according to diagram below.  
4) Place the sealing gasket then place the HE-WIFIUSB unit in the panel cutout. Place the locknut on 

the threads and tighten to hand tight.    
 NOTE: Using a tool on the plastic threads could damage the unit.   
5) Plug the HE-WIFIUSB into the USB port on controller. 
6) Turn on the controller. The HE-WIFIUSB unit will now be active.   
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CHAPTER 4: SYSTEM MENU 
 

4.1  System Menu Overview  
 

Each Horner OCS controller has a built-in System Menu, which allows the user to view the 
System Settings and make adjustments. Press the SYSTEM Key or press in the upper right of 
the screen if no buttons are visible to open the System Menu. Then use the up or down arrows 
to select and display the Wi-Fi Setting sub menu.  
 
NOTE:  XL4 screenshots were used for this manual.    
 
The HE-WIFIUSB can be set up in either Access Point Mode or Client Mode.   

• Access Point Mode  – In Access Point mode a connection from up to 8 wireless 
devices can be made to the OCS. This would allow WebMI or any other Ethernet 
based protocol as well. 

• Client Mode – - This mode allows connecting an OCS to another router or 
access point including another OCS in access point mode.  

 

4.2 Setting up Wi-Fi 
 
Step 1: In the System Menu, select “Set Networks”. 
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Step 2: In the Set Networks screen, select “WiFi Settings” 
 

 
 
 

4.3  Access Point Mode  
 
NOTE:  If a HE-WIFIUSB is plugged into the OCS, the Wi-Fi HW? will indicate Yes.   
 
Using the arrow buttons, select Wi-Fi Mode, then press the Enter arrow at the bottom right of 
the screen.  The text to the right of Wi-Fi Mode will then be highlighted with options for Access 
Point, Client, or Disable.  For Access Point Mode, select Access Point.   
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4.4 Setting up Access Point Mode 
 

 
 
Step 1:  Ensure that Wi-Fi Mode is set to Access Point.   
 
Step 2: Using arrow keys, scroll down to Network Name and press the Enter arrow. This will 
open a numeric keyboard with options for an alphabet keypad and a symbols keypad.  See 
below. Using keypads, type in the network name and press Enter. 
    

 
 
 Alphabet Keypad     Symbols Keypad 
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Step 3: Once Network Name is entered, use the arrows to scroll to Password and press the 
Enter arrow.  Once again, the Numeric keypad will appear with options to use the alphabet and 
symbols keypad.  Type in password and press Enter.  
 
 

 
 
 
NOTE:  The Encryption information will autopopulate. See below: 
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Step 4: Using the Arrow button, scroll down to Network IP and press the Enter arrow.   

 

 

Step 5: A numeric keypad will open to add the IP Address. Add address and select Enter.   
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Step 6:  Use the arrow button to scroll down to Channel. Then press the Enter arrow. Once the 
text to the right of Channel is highlighted, use an up or down arrow button to select one of the 
channel options that are supported:  Auto, Channel 1, Channel 6, or Channel 11.   
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4.5 Client Mode  
 
NOTE:  If a HE-WIFIUSB is plugged into the OCS, the Wi-Fi HW? will indicate Yes.   
 
Using the arrow buttons, select Wi-Fi Mode, then press the Enter arrow at the bottom right of 
the screen.  The text to the right of Wi-Fi Mode will then be highlighted with options for Access 
Point, Client, or Disable.  For Client Mode, select Client.   
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4.6 Setting up Client Mode 
 
Step 1:  Ensure that Wi-Fi Mode is set to Client.   
 

 
 
Step 2: Using arrow keys, scroll down to Join Network and press the Enter arrow.  
 
Step 3:  Select Join Network and the following screen will appear:  
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Once the HE-WIFIUSB has detected Access Points, the following screen will appear.  Using the 
up or down arrows, select an Access Point. The small vertical lines to the right of the Access 
Point names indicate the Wi-Fi signal strength.   

 

 

 

NOTE: This screen shows example names of Wi-Fi Access Points.   

 

Step 4: Once Join Network information is entered, use the arrows to scroll to Password and 
press the Enter arrow.  Once again, the Numeric keypad will appear with options to use the 
alphabet and symbols keypad.  Type in password and press Enter.  
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This will open a numeric keyboard with options for an alphabet keypad and a symbols keypad.  
See below. Using keypads, type in the password and press Enter. 
 
 
    

 
 
 Alphabet Keypad     Symbols Keypad 
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Step 5: Using the down arrow, scroll down to Connect Auto and press the Enter arrow.  Select 
either Yes or No by using the up or down arrows. .  

 

 

 

The Status and Client IP fields will autopopulate and the Signal Health information will update 
automatically.   
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CHAPTER 5: GENERAL CONFIGURATIOIN  
 

5.1 Wi-Fi Configuration via Cscape  
 
With device connected (where Wi-Fi is supported), open the Hardware Configuration dialog 
select  and the following window will be displayed:  
 
 
 

 
 
Select the OCS Wi-Fi Module Config to open OCS Wi-Fi Module Configuration, and the window 
below will be displayed:  
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The rest of Chapter 5 discusses configuring the Horner Wi-Fi module.  Chapters 6 through 13 
discuss configuring Ethernet resident and downloadable protocols.   
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5.2 Modes – Get Mode From 
 

 
 
Get mode from has the following options:    

• Configuration – If this option is used, the mode selected from the drop down will be 
considered. 

• Register - User can change the Wi-Fi mode dynamically by moving corresponding value 
to the Register/variable. 

             Configuration through Register for Wi-Fi mode  
Register / Variable value Mode 

0 Disabled 
1 Access point mode 
2 Client Mode 

 
• Disabled - Wi-Fi Configurations will be disabled. 
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5.3 Modes  – Access Point or Client 
 

The following modes are supported: 
 

 

 
• Disabled – Wi-Fi mode will be disabled.  
• Access Point – In Access Point mode a connection from up to 8 wireless devices can be 

made to the OCS. This would allow WebMI or any other Ethernet based protocol as 
well. 

• Client –This mode allows an OCS to connect to an existing router or access point 
including another OCS in access point mode.  

 

 

5.4 – Wi-Fi Update 
 

 
 

This option is used only when Wi-Fi configuration needs to be updated dynamically. When the 
register / Variable is set to "1" or "high", Wi-Fi configuration will be updated. 

If access point SSID/Password or Client Mode SSID/password is configured through 
registers/Variables, then the dynamic change in SSID/Password will take effect only after 
triggering the Wi-Fi update register/Variable. 
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5.5 Access Point Mode 
 

 

• SSID - This is a unique ID that consists of 16 characters and it is used for naming 
wireless networks. This field can be configured either with constants or via 
register/variable. 

 
• Password - This is the password that is set for the SSID. This field can be configured 

either with constants or via register/variable. 
 

• Security – This option is set to WPA2. 
 

• Channel - The following channels are supported - Auto, Channel 1, Channel 6 and 
Channel 11. The channel can be selected from the drop-down box or it can be 
configured using registers/variable to change it dynamically by moving corresponding 
value to the register/variable. 

 
             Configuration through Register for Wi-Fi channel 

Register / Variable value Channel 
1 Channel 1 
2 Channel 6 
3 Channel 11 

Else Auto 
 
 

NOTE:  

1. Allowed special character in SSID or Password is ~!@#$%^&*()_+-+.<> 
2. Access Point SSID Minimum allowed length is 4 
3. Access Point SSID Maximum allowed length is 32 
4. Access Point password Minimum allowed length is 8 
5. Access Point password Maximum allowed length is 32  
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5.6 Client Mode 
 

 
 

• SSID – This is a unique ID that consists of 32 characters and is used for naming 
wireless networks. This field can be configured either with constants or via registers.  

• Password – This is the password that is set for the SSID. This field can be configured 
either with constants or via registers.   

• Auto Connect – Selecting this option connects to the previously established connection 
(SSID) automatically.  

NOTE:  Allowed special character SSID or password  ~!@#$%^&*()_+-+.<> 
 

5.7 Status  
 
The Status Register provides real-time diagnostics at run-time. The status register can be 
configured as a word-type register (ie %R), or 16 consecutive bit-type references (ie %T or 
%M) aligned to a word boundary (ie %T1, %T17, %T33, etc.).  
 

 
 
 

Bits for Status Register (Status of the Wi-Fi Connectivity) 
Bit 1 High if Wi-Fi Module is connected / Low if Wi-Fi Module is disconnected 
Bit 2 High when Access Point is established successfully 
Bit 3 High when Client mode is connected successfully 
Bit 4 High when Scanning in Client mode (Scan mode is to scan for available networks. This 

mode is available only in the System Menu of device.) 
Bit 5 It will be set if configured Access Point SSID is invalid 

 
Bit 6 It will be set if configured Access Point password is invalid 
Bit 7 - 8 Reserved 
Bits 9 – 12 Signal strength when devices in ST mode 

0 = None 
1 = Weak 
2 = Fair 
3 = Good 
4 = Excellent 
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5.8 Advanced Settings 
 

 
 

• SSID Broadcast – It is the continuous transmission of packets form a Wi-Fi access point 
that announced its availability. Selecting this option makes the SSID to be visible to 
other devices. 

• Country Code – This is the country code where the Wi-Fi router is currently being 
operated.  See Table 5.1 below.    
 

Table 5.1 - Example List of Supported Country Codes 

US United States 

CA Canada 

DE Germany 

NL Netherlands 

IT Italy 

PT Portugal 

LU Luxembourg 

NO Norway 

FI Finland 

DK Denmark 

CH Switzerland 

CZ Czech Republic 

ES Spain 

GB United Kingdom 

FR France 

AU Australia 

AT Austria 

GR Greece 

IS Iceland 

IN India 

IE Ireland 

LI Liechtenstein 

PL Poland 

PR Puerto Rico 
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5.9  Wi-Fi General LAN Config 
 
In OCS Wi-Fi Module configuration dialog, clicking on General LAN Config button will display 
the following window, where the user can configure the Ethernet protocols to be accessed via 
Wi-Fi connectivity. 
 

 
 
Select Genera LAN Config>> to open the General LAN Configuration dialog below:  
 

 
 
See Also:  [ICMP], [EGD], [SRTP], [Modbus Slave], [FTP], [HTTP], [ASCII Over TCP/IP]  



  MAN1234-03-EN_HE-WIFIUSB _UM 

D e c e m b e r  1 ,  2 0 2 0      P a g e  32 | 121 
 

 

5.10 Wi-Fi Configuration through System Menu 
 
Each OCS controller has a built-in System Menu, which allows the user to view the System 
Settings and make adjustments. Press the SYSTEM Key or press in the upper right corner of 
the screen if no buttons are visible to open the System Menu. Then use the up or down arrows 
to select and display the Wi-Fi Setting sub menu.  
 
See [System Menu] for more details.   
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CHAPTER 6: RESIDENT PROTOCOLS 
(ETHERNET) 
 

 
 
NOTE: The following configuration is required for all applications regardless of the protocols 

used. Additional configuration procedures must be performed for each protocol used as 
described in the configuration sections of the next several chapters. 

 
Clicking on General LAN Config>> option will display the following window where the user can 
configure the Ethernet protocols to be accessible via Wi-Fi connectivity. 
 
NOTE: Any 16-bit register can be used.   
 
 

 

    



  MAN1234-03-EN_HE-WIFIUSB _UM 

D e c e m b e r  1 ,  2 0 2 0      P a g e  34 | 121 
 

CHAPTER 7: ICMP CONFIGURATION 
 

7.1 ICMP Overview 
 
ICMP is used for diagnostic purposes only, to determine if another device exists on the Ethernet 
network. 
 
Using ICMP, the OCS sends Ping Echo Requests to another device and expects the other device 
to answer with Ping Echo Responses. The OCS measures the round-trip time of each Ping Echo 
Request / Response exchange and puts the result (in milliseconds) into an OCS register. 
 
In addition, when the OCS receives a Ping Echo Request from another device, it answers with a 
Ping Echo Response. 
 
NOTE: Although ICMP supports other network diagnostics, the OCS only supports Ping. 
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7.2 ICMP Configuration 
 
If ICMP protocol will be used in the application, ICMP Configuration must be performed, in 
addition to the general OCS Wi-Fi  Configuration previously described in Chapter 5. To configure 
ICMP protocol, use Cscape Programming Software to perform the following five steps: 
 
1. Open OCS Wi-Fi LAN configuration dialog by selecting Controller → Hardware 

Configuration (select a series and device type)→ (OCS Wi-Fi Module) Config → General 
LAN config.  Then select ICMP (Ping) → Configure Selected Protocol.  

 

 
 
2. Enable ICMP by checking the ICMP (Ping) checkbox in the LAN1 Configuration dialog. 
 
3. Click on the Configure Selected Protocol button next to the ICMP (Ping) checkbox to open 

the ICMP Configuration dialog. Refer to figure below.  
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4. Set up the ICMP Configuration parameters as follows: 
 

Table 7.1 – ICMP Configuration Parameters   
Ping IP Reg Enter an OCS Register reference (such as %R200) to indicate which 32-bit 

OCS register will be read to obtain the IP Address of the network device to 
send Ping Echo Requests to. 

Ping Time Reg Enter an OCS Register reference (such as %R202) to indicate which 32-bit 
DINT OCS register will be written with the Ping Echo Request / Response 
round-trip time (in milliseconds). If no response is received within the Ping 
Timeout interval, a Ping Time of -1 is reported, indicated a timeout.  

Ping Timeout Enter a number between 100 and 100,000 for how often (in milliseconds) the 
OCS should send Ping Echo Requests.  If the response takes longer than this 
amount of time, it is considered a timeout.  

 
 
5. Click OK to accept the new ICMP Configuration. 
 

 

7.3 ICMP Operation 
 
To start Ping Echo Requests, use Ladder Code, User Screens, or Cscape Data Watch to write an 
IP Address to the OCS register indicated by Ping IP Reg. To check the resulting Ping Echo 
Response times, read the OCS register indicated by Ping Time Reg. If the round-trip time 
exceeds the configured Ping Timeout (or if there is no response at all), the reported response 
time will be -1. 
 
To stop Ping Echo Requests, write 0.0.0.0 to the OCS register indicated by Ping IP Reg. 
 
NOTE: ICMP protocol is active even when the OCS is not in RUN mode. Therefore, when the 

OCS is not in RUN mode, User Screens and Cscape Data Watch can still be used to 
control and monitor ICMP Pinging. 
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CHAPTER 8:  EGD (ETHERNET GLOBAL DATA) 
 

8.1 EGD Overview 
 
Ethernet Global Data (EGD) protocol is a GE Fanuc Automation protocol, which is designed for 
simple, efficient data exchanges between peer devices on a network. 
 
EGD protocol communicates using the UDP transport layer. Although this method of data 
transfer is very efficient, it has no specific way to detect and recover lost data packets. 
However, since all EGD data transfers are periodic, lost data packets will be repeated when their 
user-configured time periods expire. 
 
CAUTION: EGD protocol is not intended for one-time event notification or for applications 

with critical data, which cannot withstand being delayed as described above. 
 
Each device on an EGD network can be configured as a Producer, as a Consumer, or both.  
 
A Producer is a device that transmits Exchanges (blocks of data) to one or more Consumers. A 
Producer can transmit Exchanges directly to a specific Consumer, by sending them to the 
Consumer’s IP Address. (This is Unicast IP Addressing.) A Producer can also transmit Exchanges 
to a Group of Consumers, by sending them to a Group ID. (This is Multicast IP Addressing.) See 
Section 8.12 for more details regarding Unicast and Multicast IP Addressing. 
 
A Consumer is a device that receives Exchanges from one or more Producers. 
 
An OCS supports up to 127 concurrent Exchanges, each of which can be either a Producer or a 
Consumer of data. 
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8.2 EGD Terminology 
 
Before configuring an OCS for EGD protocol, it is essential that the application programmer 
understand the key EGD terms, which are shown in Table 8.1. 
 

Table 8.1 – EGD Terminology 
Term Definition 

Exchange  
A block of data sent by a Producer and received by one or more 
Consumers 

Exchange Number  
A number (1 to 16,383), which along with the IP Address of the 
Producer, is used to uniquely identify an Exchange on an EGD 
network 

Producer  
An EGD network device configured to transmit one or more 
Exchanges 

Consumer  An EGD network device configured to receive one or more Exchanges 

Produced Exchange  
A block of data that a Producer sends to a Consumer or to a Group of 
Consumers 

Consumed 
Exchange  

A block of data that a Consumer or Group of Consumers receives 
from a Producer 

Group  
One or more Consumers that are configured to receive Exchanges, 
which have been sent by a Producer to a specific Group ID 

Group ID A number (1 to 32), which is used to identify a Group of Consumers 

Production Period 
A value (in milliseconds) that specifies how often a Produced 
Exchange is transmitted to the network 

Update Timeout  

A value (in milliseconds) that specifies how long a Consumer will wait 
to receive an Exchange, before considering it late.  
 
NOTE: In general, a Consumed Exchange’s Update Timeout is 
normally set to at least twice the corresponding Produced 
Exchange’s Production Period, plus 10ms. 

Unicast 
Peer-to-peer communication in which data is sent to a SINGLE device 
at a specific IP Address.    

Multicast 
Peer-to-peer communication in which data is sent to a GROUP IP 
Address, and all devices in that group will receive the data.   
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8.3 EGD Configuration 
 
1. Open OCS Wi-Fi LAN configuration dialog by selecting Controller → Hardware 
Configuration (select a series and device type)→ (OCS Wi-Fi Module) Config → General LAN 
config.  Then select EGD (Ethernet Global Data) → Configure Selected Protocol.  
 

 
 
2. Click on the Configure Selected Protocol button after selecting EGD (Ethernet Global Data) 

to open the Ethernet Global Data dialog. 
 

NOTE: The Ethernet Global Data dialog allows EGD Produced and Consumed Exchanges to 
be configured. To configure Produced Exchanges, select the Produced Exchanges 
tab; to configure Consumed Exchanges, select the Consumed Exchanges tab. Refer 
to figure below.  
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8.4 EGD Produced Exchange Configuration 
 

 

Table 8.2 – Produced Exchange Unicast & Multicast 
 

 

Unicast To configure a unicast communication, use the IP address of the other 
device.  

 

Multicast 
 

 

To configure a multicast communication, use a Group Number.  

 
 
1. In the upper window, one or more Produced Exchanges can be created. 
2. In the lower window, I/O Blocks can be defined for each Produced Exchange. 
 

 
 

When creating a Produced Exchange, the application programmer selects an Exchange Number 
for it, determines whether the Exchange will be sent to a specific Consumer or to a Group of 
Consumers, chooses which Consumer or Group of Consumers will receive the Exchange, and 
sets how often the Exchange will be sent to the EGD network. 
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When defining I/O Blocks for a Produced Exchange, the application programmer selects what 
type and how much information will be associated with the Exchange. For Produced Exchanges, 
there are two types of I/O Blocks to choose from: Data and Status.  
 

Table 8.3 – Produced Exchange I/O Block Type Definitions 
Type Definition 

 
Data Block 

 
Block of consecutive OCS registers to be sent periodically to the EGD network 

 
Status Block 

 
16-bit OCS register to be written with the Produced Exchange’s Status Word 

 
When defining Data Blocks for a Produced Exchange, the maximum total OCS register data the 
Exchange can send to the EGD network is 1400 bytes. This means that up to a total of 700 16-
bit registers (%R, %AI, AQ, etc.), or 11,200 1-bit registers (%M, %T, %I, %Q, etc.), or a 
combination thereof can be defined for a Produced Exchange. 
 
NOTE: The OCS allows a total of up to 256 Data Blocks to be defined for all Produced Exchanges 

combined. This means that if 127 Produced Exchanges are configured, each can have an 
average of about 2 Data Blocks defined. 

 
When a Status Block is defined for a Produced Exchange, exactly 2 bytes of register data are 
written with the Produced Exchange’s Status Word.  
 
NOTE:  The OCS maintains just one 16-bit status word for each Produced Exchange. For this 

reason, there is never any need to define more than one Status Block for a given 
Produced Exchange. 
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8.5 EGD Produced Exchanges: Unicast and Multicast 
 
To create unicast or multicast EGD Produced Exchanges, perform the following six steps: 
 
1a. To configure a UNICAST communication: After opening the Ethernet Global Data 

Configuration dialog, click on the Add Exch button to open the Add / Edit Produced 
Exchange dialog (Figure 5.5). Select the destination Address and enter information.   
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1b. To configure a MULTICAST communication: After opening the Ethernet Global Data 
Configuration dialog, click on the Add Exch button to open the Add / Edit Produced 
Exchange dialog. Select and assign Group ID.   

 

 
 

2. Configure the Produced Exchange parameters as follows: 
 

Table 8.4 - Produced Exchange Parameters 
Exchange Number Enter a number between 1 and 16,383, which will be used to identify 

the Exchange to be sent. 
IP Address Radio Button Select this option if the Exchange will be sent to a specific 

Consumer. This is a Unicast exchange. (This will cause the next edit 
box to be for entering IP Address, instead of Group ID.) 

Group ID Radio Button Select this option if the Exchange will be sent to a Group of 
Consumers. This is a Multicast exchange. (This will cause the next 
edit box to be for entering Group ID, instead of IP Address.) 

IP Address Edit Box If the IP Address radio button was selected, enter the IP Address of 
the specific Consumer that will receive the Produced Exchange. 

Group ID Edit Box If the Group ID radio button was selected, enter the Group ID 
number (1 to 32) of the Group of Consumers that will receive the 
Produced Exchange. 

Production Period Enter a number (in milliseconds) for how often the Produced 
Exchange will be sent to the EGD network. 
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3. Click OK to accept the new Produced Exchange configuration, which will be now be displayed 
in the upper window of the Ethernet Global Data dialog (Figure 5.2). 

 
4. To add another Produced Exchange to the list, click on the Add Exch button again. 
 
5. To edit or delete a Produced Exchange, highlight it in the upper window of the Ethernet 

Global Data Configuration dialog, and then click on the Edit Exch button or the Delete Exch 
button. 

 
6. To quickly change the IP Address in multiple Produced Exchanges, click on the Replace Addr 

button. This will open a dialog to allow the user to search and replace the IP Address 
parameter, in all Produced Exchanges simultaneously. 
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8.6 Defining EGD Produced Exchange I/O Blocks 
 
After creating a Produced Exchange, one or more I/O Blocks should be defined for it. An I/O 
Block specifies what type and how much information will be associated with the Produced 
Exchange. 
 
To define I/O Blocks for a Produced Exchange, perform the following six steps: 
 
1. In the upper window of the Ethernet Global Data dialog, highlight one of the Produced 

Exchanges, and then click the Add Range button to open the Add I/O Range to Exchange 
dialog. 
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2. Configure the I/O Block parameters as follows: 
 

Table 8.5 – I/O Block Parameters  
 
 
        Type 

Select Data Type to define a block of OCS registers, which the 
Produced Exchange will periodically read and send to the EGD 
network. Select Status Type to define a 16-bit OCS register, 
which will be written with the Produced Exchange’s Status 
Word. 

 
 
      Address 

Enter an OCS Register reference (such as %R1000), for the 
first OCS register, in a block of OCS registers, that will be 
periodically read and sent (Data Type), or for a 16-bit OCS 
register that will be written with status information (Status 
Type). 
 

Number of Registers If Data Type was selected, enter the number of registers to be 
periodically read and sent. If Status Type was selected, this 
edit box changes to Number of Bytes, and always has a fixed 
value of 2. 
 

 
3. Click OK to accept the Produced Exchange’s new I/O Block, which will be now be displayed 

in the lower window of the Ethernet Global Data Configuration dialog (Figure 6.1). 
 

NOTE: The OCS registers, specified in Data Block definitions, are sent to the EGD 
network in top-to-bottom order, as they appear in the lower window of the 
Ethernet Global Data Configuration dialog. 

 
4. To add another I/O Block, click the Add Range button again and repeat steps 2 and 3. The 

new I/O Block will appear at the end of the list. 
 
5. To insert an I/O Block into the middle of the list, highlight one of the I/O Block items in the 

list and then click on the Insert Range button. In this case, the new I/O Block will be inserted 
just before the highlighted I/O Block. 

 
6. To edit or delete an I/O Block in the list, highlight it and then click on the Edit Range or 

Delete Range button. 
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8.7 EGD Consumed Exchange Configuration 
 
 
To configure EGD Consumed Exchanges, open the Ethernet Global Data Configuration dialog, 
and select the Consumed Exchanges tab, where: 
 
1. In the upper window, one or more Consumed Exchanges can be created. 
2. In the lower window, I/O Blocks can be defined for each Consumed Exchange. 
 
When creating a Consumed Exchange, the application programmer selects an Exchange 
Number for it, determines whether to receive the Exchange as a single Consumer or as a 
member of a Group of Consumers, chooses which Producer to receive the Exchange from, and 
sets how often to expect the Exchange to be received. 
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When defining I/O Blocks for a Consumed Exchange, the application programmer selects what 
type and how much information will be associated with the Exchange. For Consumed Exchanges, 
there are five types of I/O Blocks to choose from: Data, Status, Timestamp, OCS Timestamp, 
and Filler. Table 8.6 shows these I/O Block Types along with their definitions: 
 

Table 8.6 – Consumed Exchange I/O Block Type Definitions 
Type Definition 

Data Block 

Block of consecutive OCS registers to be written with received data.  
When defining Data Blocks for a Consumed Exchange, the maximum 
total OCS register data the Exchange can receive from the EGD 
network is 1400 bytes. This means that up to a total of 700 16-bit 
registers (%R, %AI, AQ, etc.), or 11,200 1-bit registers (%M, %T, %I, 
%Q, etc.), or a combination thereof can be defined for a Consumed 
Exchange. 
 
NOTE: The OCS allows a total of up to 256 Data Blocks to be defined 

for all Consumed Exchanges combined. This means that if 127 
Consumed Exchanges are configured, each can have an 
average of about 2 Data Blocks defined. 

 

Status Block 

16-bit OCS register to be written with the Consumed Exchange’s status 
word. When a Status Block is defined for a Consumed Exchange, 
exactly 2 bytes of register data are written with the Consumed 
Exchange’s Status Word.  

Timestamp Block 

Exactly 8 bytes of register data will be written with two 32-bit binary 
timestamp values, containing the numbers of seconds and 
nanoseconds since January 1, 1970.  
  
NOTE:  The binary Timestamp Block is rarely used, and there is never 

any need to define more than one Status Block or OCS 
Timestamp Block for a given Consumed Exchange. 

OCS Timestamp Block 

Exactly 14 bytes of register data will be written with a 7-word OCS-
format timestamp, consisting of second, minute, hour, day, month, 
year, and millisecond words. This OCS Timestamp can be displayed on 
the OCS screen, can be loaded into the OCS time-of-day clock, and 
can be more easily processed by ladder logic.  

 
Filler Block 
 

Specifies a block of received data to ignore (skips unwanted data). 
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8.8 Creating EGD Consumed Exchanges 
 
To create EGD Consumed Exchanges, perform the following six steps: 
 
1. In the Ethernet Global Data Configuration dialog, click on the Add Exch button to open the 

Add / Edit Consumed Exchange dialog. Refer to image below.  
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2. Configure the Consumed Exchange parameters as follows: 
 

Table 8.7 – Consumed Exchange Parameters 
Exchange Number Enter a number between 1 and 16,383, which will be used to 

identify the Exchange to be received. 
Producer IP Address: Enter the IP Address of the Producer to receive the Exchange 

from. 
Use Group ID Check this box to receive an Exchange sent by a Producer to a 

Group ID. 
Group ID If the Use Group ID box is checked, enter a number from 1 to 32 in 

the edit box, to identify which of the 32 possible Groups of 
Consumers to become a member of. 

Update Timeout Enter a number (in milliseconds) for how long to wait to receive 
the Exchange, before considering it to be late. Typically, this 
should be set to twice the corresponding Production Timeout, 
plus 10 milliseconds. 

 
3.  Click OK to accept the new Consumed Exchange configuration, which will be now be displayed 

in the upper window of the Ethernet Global Data Configuration dialog. 
 
4. To add another Consumed Exchange to the list, click on the Add Exch button again. 
 
5. To edit or delete a Consumed Exchange, highlight it in the upper window of the Ethernet 

Global Data Configuration dialog, and then click on the Edit Exch or Delete Exch button. 
 
6. To quickly change the Producer IP Address in multiple Consumed Exchanges, click on the 

Replace Addr button. This will open a dialog to allow the user to search and replace the 
Producer IP Address parameter, in all Consumed Exchanges simultaneously. 
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8.9 Defining EGD Consumed Exchange I/O Blocks 
 
After creating a Consumed Exchange, one or more I/O Blocks should be defined for it. An I/O 
Block specifies what type and how much information will be associated with the Consumed 
Exchange. 
 
To define I/O Blocks for a Consumed Exchange, perform the following six steps: 
 
1. In the upper window of the Ethernet Global Data Configuration dialog, highlight one of the 

Consumed Exchanges, and then click the Add Range button to open the Add I/O Range to 
Exchange dialog. 

 

 
  



  MAN1234-03-EN_HE-WIFIUSB _UM 

D e c e m b e r  1 ,  2 0 2 0      P a g e  52 | 121 
 

2. Configure the I/O Block parameters as follows: 
 

Table 8.8– I/O Block Parameters 
 
 
    Type 

Select Data Type to define a block of OCS registers, which the 
Consumed Exchange will write with received data. Select Status 
Type to define a 16-bit OCS register, which will be written with the 
Consumed Exchange’s Status Word. Select OCS Timestamp Type to 
define a 14-byte OCS register block to write with the received data’s 
OCS-format timestamp. Select Filler Type, to skip unwanted 
received data. 

 
 
    Address 

Enter an OCS Register reference (such as %R2000), for the first 
OCS register, in a block of OCS registers, that will be written with 
received data (Data Type), or for a 16-bit OCS register that will be 
written with status information (Status Type), or for the first OCS 
register in a block of OCS registers that will be written with the 14-
byte timestamp (OCS Timestamp Type). For Filler Type, the Address 
edit box is not used. 

 
 
Number of Registers 

If Data Type was selected, enter the number of registers to be 
written with received data. Otherwise, this edit box changes to 
Number of Bytes, and has a fixed value of 2 for Status Type or 14 
for OCS Timestamp Type. For Filler Type, enter the number of 
unwanted received data bytes to skip. 

 
3. Click OK to accept the Consumed Exchange’s new I/O Block, which will be now be displayed 

in the lower window of the Ethernet Global Data dialog.  
 

NOTE: The OCS registers, specified in Data Block definitions, are filled with received data in 
top-to-bottom order, as they appear in the lower window of the Ethernet Global Data 
dialog. In this respect, Filler Blocks are placeholders for Data Blocks and can be 
thought of as Data Blocks whose received data bytes are discarded. 

 
4. To add another I/O Block, click on the Add Range button again and repeat steps 2 and 3. 

The new I/O Block will appear at the end of the list. 
 
5. To insert an I/O Block into the middle of the list, highlight one of the I/O Block items in the 

list and then click on the Insert Range button. In this case, the new I/O Block will be inserted 
just before the highlighted I/O Block. 

 
6. To edit or delete an I/O Block in the list, highlight it and then click on the Edit Range or 

Delete Range button. 
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8.10 Adding an OCS Timestamp Block Configuration 
 
In EGD protocol, a timestamp is sent with every Produced Exchange, indicating when the 
Producer sampled the data being sent. For a Consumer of the Exchange to get this information 
into an OCS register, define an OCS Timestamp Block for the Consumed Exchange. Perform the 
following 2 steps: 
 
1. In the EGD Configuration dialog, select the Consumed Exchanges tab. 
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2. Make sure an exchange is highlighted in the upper and click on the Add Range button, 
to define an OCS Timestamp Block for Consumed Exchange. Then fill in the 
parameters, as shown in below, and click OK. 

 

 
 
 
 

 
  



  MAN1234-03-EN_HE-WIFIUSB _UM 

D e c e m b e r  1 ,  2 0 2 0      P a g e  55 | 121 
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8.11 Filler Block Configuration 
 
Sometimes a Consumer does not need all of the data sent by a Producer in an Exchange. In this 
case, the Consumed Exchange’s Data Block should be defined to receive fewer registers than 
will be sent by the Producer of the Exchange. 
 
However, if the partial data needed by the Consumer is not at the beginning of the data received 
in an Exchange, there must be some way to skip (ignore) the extra data. For this reason, the 
Ethernet Module supports Filler Blocks for Consumed Exchanges. 
 

A Filler Block is used to skip unwanted data sent by the Producer. For example, if the Producer 
sends 40 data bytes in an Exchange, and the Consumer only needs the first and last 10 bytes, a 
Filler Block would be defined, in the appropriate slot in the list, to skip the middle 20 bytes of 
data. 
 
Filler Produced Exchange Example: Controller A (IP 192.168.0.1) 
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Filler Consumed Exchange Example: Controller B (IP 192.168.0.2) 
 
NOTE: The filler is used to skip the middle 20 bytes of Exchange 1.  

 

 
 
  



  MAN1234-03-EN_HE-WIFIUSB _UM 

D e c e m b e r  1 ,  2 0 2 0      P a g e  58 | 121 
 

8.12 EGD Unicast and Multicast 
 
When using Ethernet Global Data (EGD) protocol for peer-to-peer communication, there are two 
methods for sending data: (1) send to a single device or (2) send to a group of devices.  
 
Unicast 
When sending to a single device (method 1), EGD protocol uses Unicast IP Addressing. This 
means that the IP header’s 32-bit Destination IP Address will contain the intended recipient’s 
unique IP Address. 
 
 
Multicast 
When sending to a group of devices (method 2), EGD protocol uses Multicast IP Addressing.  
 
This means that the IP header’s 32-bit Destination IP Address will contain one of the 32 Multicast 
IP Addresses shown in Table 8.9. 
 

Table 8.9 – EGD Multicast IP Addressing  
Group ID Multicast IP Address 

1 224.0.7.1 

2 224.0.7.2 

: 
: 

: 
: 

32 224.0.7.32 

 

Ethernet Switches normally do not support Multicast IP Addressing, while Ethernet Hubs do 
support Multicast IP Addressing. Some Ethernet Routers, known as Multicast Routers, do 
support Multicast IP Addressing, by using Internet Group Management Protocol (IGMP). 
 
NOTE: For those customers wanting to use Multicast Routers to connect EGD devices, the OCS 

automatically handles IGMP communication with Multicast Routers. 
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8.13 EGD Status Words 
 
EGD Status Words allow an Ethernet Global Data user to obtain the operating status of each 
EGD Exchange. The set of EGD Status Word values, implemented in the OCS, is a subset of the 
ones used in GE Fanuc EGD devices. This is because the OCS does not support dynamically 
defined (at run time) EGD Exchanges. 
 
NOTE:  Both Produced and Consumed Exchange Status Words are written to local OCS registers. 

This is the only case where a Produced Exchange can be configured to write to a local 
register. 

 
The Status Word for a Produced Exchange is updated each time the Exchange’s Production 
Period expires. The Status Word for a Consumed Exchange is updated when new data arrives 
for consumption or when the Exchange’s Update Timeout expires. 
 
In normal operation, each EGD Exchange’s Status Word will always be 1 (OK), implying that new 
data was successfully Produced or Consumed. If the application needs to be notified when a 
data transfer has occurred on a given Exchange, the ladder program should clear the 
Exchange’s Status Word register to 0 (IDLE) each time a non-zero event is detected. 
 

 

 

8.14 EGD Produced Exchange Status Words  
 
The Status Word for an EGD Produced Exchange can take on the following values: 
 

Table 8.10 – Status Word for EGD Produced Exchange 
0  IDLE No new status event has occurred. The OCS initializes all Status Words to 

0, only at power-up and each time the OCS enters RUN mode. 
Subsequently, the OCS application ladder program can write the value 0 
to the Status Word, as an aid in knowing when Ethernet Global Data 
production occurs (see Status Word 1). 

1  OK Data Produced. New EGD network data has been transmitted. A transition 
to 1 indicates production of data occurred since the last OCS ladder scan. 

2 NO LINK The Ethernet link was down when EGD data production was attempted. 
This will occur, for example, if the Ethernet cable is unplugged from the 
OCS. 
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8.15 EGD Consumed Exchange Status Words 
 
The Status Word for an EGD Consumed Exchange can take on the following values: 
 

Table 8.11 – Status Word for EGD Consumed Exchange 
0  IDLE No new status event has occurred. The OCS initializes all Status Words to 

0, only at power-up and each time the OCS enters RUN mode. 
Subsequently, the OCS application ladder program can write the value 0 
to the Status Word, as an aid in knowing when Ethernet Global Data 
consumption occurs (see Status Words 1 and 7). 

1  OK Data Consumed. New EGD network data has been received as expected 
(before the configured Update Timeout expired). A transition to 1 (or to 
7) indicates consumption of data occurred since the last OCS ladder scan. 

2 NO LINK The Ethernet link was down when EGD data consumption was expected. 
This will occur, for example, if the Ethernet cable is unplugged from the 
OCS. 

3 No SYNC  SNTP Error – The Ethernet Interface in the device producing the exchange 
is configured for network time synchronization (Network Time Sync 
parameter is set to SNTP) but is not synchronized to an SNTP server. 
Therefore, the timestamp associated with this data is not synchronized 
to the network.  
 
NOTE: This error condition is considered the least important of all the 
error codes in this section. If another error condition exists, its status 
code will appear in the Status Word. 

6 OVERDUE  Data Refresh Error – The Update Timeout has expired without receiving 
the expected data. Some possible causes for this error are: (1) the 
Producer has stopped producing the data, (2) the Consumed Exchange’s 
configured Producer IP Address and/or Group ID do not exactly match 
those of the corresponding Produced Exchange, (3) or the Consumed 
Exchange’s configured Update Timeout is too short (it should normally be 
twice the producer’s Production Period, plus 10ms). 

7 TARDY   Data Consumed Late – New EGD network data has been received, but it is 
later than expected (after the configured Update Timeout expired). A 
transition to 7 (or to 1) indicates consumption of data occurred since the 
last OCS ladder scan. The most probable cause for this error is that the 
Consumed Exchange’s configured Update Timeout is too short (it should 
normally be twice the producer’s Production Period, plus 10ms). 
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8.16 EGD Example 1: UNICAST EXCHANGE 
 
 

 
EGD Example 1: Configuration of Node 1 
 
To configure Node 1 for EGD Example 1, as shown above, perform the following six steps: 
 
1.  To configure EGD Exchanges, open the Ethernet Global Data Configuration dialog.  
 
In this example Node 1 will have a Static IP address, and the %R1, %R2, and %R3 registers will 
be used to report the Ethernet Module’s status, firmware version, and IP address.   
 
NOTE: Since an IP Address is 32-bits long, Node 1’s IP Address (192.168.0.1) will actually be 

written into %R3 and %R4.   
 

  

 
Node 1 

 
IP Address 
192.168.0.1 

 
Node 2 

 
IP Address 
192.168.0.2 

 

Exchange 1: Produced by Node 1; Consumed 
by Node 2; 192.168.0.1 sends 10 words of data 
every 100ms to 192.168.0.2.  

Exchange 2: Produced by Node 2; Consumed 
by Node 1; 192.168.0.2 sends 5 words of data 
every 200ms to 192.168.0.1.  
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2. Click on LAN1 next to the EGD (Ethernet Global Data) checkbox to open the Ethernet Global 
Data dialog. Click on Add Exch in the Produced Exchanges dialog.  
  

 
 
 

3. Click on Add Range button, in the EGD Configuration dialog, to define a Data Block for 
Produced Exchange 1. Then fill in the parameters as shown below. Then click OK.  
 
In this example, Node 1 will use Exchange 1 to transmit 10 words of data taken from %R100 
through %R109.  
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4.  To configure Exchange 2 as Consumed Exchange for Node 1, select the Consumed 
Exchanges tab in the Ethernet Global Data dialog. Click on the Add Exch button to 
create a Consumed Exchange. Then fill in the parameters as shown.   

 
NOTE: This is a unicast. Node 1 will be the only Consumer to receive Exchange 2 from Node 2 

and will NOT be a member of a Group of Consumers. Also, the Update Timeout is set to 
410ms, which means Node 1 will expect to receive Exchange 2 from Node 2 at least 
every 410ms. [This is twice the time, plus 10ms.] 
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5.  Click on the Add Range button in the EGD Configuration dialog to define a Data Block 
for Consumed Exchange 2. Then fill in the parameters as shown below and click OK.   

 
In this example, Node 1 will use Exchange 2 to receive 5 data words in %R200 through 
%R204.  

 
At this point, the Consumed Exchanges tab in the EGD Configuration dialog should be as 
shown 

 

 
 
6.  Node 1 configuration is now complete. Click OK, save the program using an appropriate 

filename, such as EGD Node 1.csp, and then continue with, Node 2 Configuration.  
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EGD Example 1 – Configuration of Node 2 

To configure Node 2 for EGD Example 1, perform the following steps: 
 
1. On the main Cscape screen, select New on the File menu to start a new user program. To 
configure EGD Exchanges, open the Ethernet Global Data Configuration dialog.  
 
In this example, Node 2 will have a Static IP Address, and the %R1, %R2, and %R3 registers 
will be used to report the Ethernet Module’s status, firmware version, and IP Address.   
 
NOTE: Since an IP address is 32-bits long, Node 2’s IP Address (192.168.0.2) will actually be 

written into %R3 and %R4.  
 
Node 2 will transmit Exchange 2 to a specific Consumer (Node 1) because this is a unicast 
communication, instead of to a group of Consumer (multicast).   
 
The Production Period is set to 200, which will cause Node 2 to transmit Exchange 2 every 
200ms.  
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3. Click on the Add Range button in the EGD Configuration dialog to define a Data Block for 
Produced Exchange 2. Then fill in the parameters as shown below and click OK.  
 
In this example, Node 2 will use Exchange 2 to transmit 5 words of data taken from %R100 
through %R104.  
 

 
 
At this point, the Produced Exchanges tab in the EGD Configuration dialog should be as shown 
in the figure below.  
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4. Now that Exchange 2 has been configured as a Produced Exchange for Node 2, it is time to 
configure Exchange 1 as a Consumed Exchange for Node 2. To do this, first select the 
Consumed Exchanges tab and click on the Add Exch button to create a Consumed Exchange.  
 

 
 
 
 
Then fill in the parameters, as shown below and click OK.   
 
In this example, Node 2 will be the ONLY consumer to receive Exchange 1 from Node 1 and will 
NOT be a member of a Group of Consumers. Also, the Update Timeout is set to 210, which 
means that Node 2 will expect to receive Exchange 1 from Node 1 at least every 210ms.  
 
NOTE: This is twice the time, plus 10ms that Node 1 was configured to transmit Exchange 1.  
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5. Click on the Add Range button, in the EGD Configuration dialog to define a Data Block for 
Consumed Exchange 1. Then fill in the parameters as shown below and click OK.  
 
In this example, Node 2 will use Exchange 1 to receive 10 data words from %R200 through 
%R209.  
 

 
 
Click OK so that dialog matches the one below.  
 

 
 
 

6. Node 2 configuration is now complete. Click OK and save the user program using an 
appropriate filename, such as EGD Node 2.csp, and then start EGD communication between 
Node 1 and Node 2.  
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EGD Example 1 – Starting EGD Communication between Node 1 & Node 2 

Now that both Node 1 and Node 2 have been configured for Example 1, start them 
communicating following these steps: 
 
1. Open the saved Node 1 user program (EGD Node 1.csp), and download it to Node 1. 
2. Open the saved Node 2 user program (EGD Node 2.csp) and download it to Node 2. 
3. Connect both Node 1 and Node 2 to an Ethernet network and put them both in RUN mode.  
 
At this point, Node 1 and Node 2 should be exchanging EGD data as follows: 
 

1. Every 100ms, Node 1 will read its %R100 through %R109 registers and send 
them via Exchange 1 to be received by Node 2’s %R200 through %R209 
registers. 
 

2. Every 100ms, Node 2 will read its %R100 through %R104 registers and send 
them via Exchange 2 to be received by Node 1 into Node 1’s %R200 through 
%R204 registers.  
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8.17 EGD Example 2 -  MULTICAST EXCHANGE 
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EGD Example – CONFIGURING NODE 1 

The following are the production and consumption range details: 
 

Table 8.12 – EGD Example Specifications  
Node 1 – Production Node 

Exchange #1: Production Details Exchange #1: Produced Range Details 
Exchange Number #1 Byte Offset Start Length 
Produced to Group 1 0 %R1001 50 
Production Period 100mS 100 %R1501 25 

150 %R1601 25 

 
Node 2 – Consumption Node 

Exchange Number #1 Type Byte Offset Start Length 
Producer IP 192.168.0.1 Data 0 %R1 50 
Group Data ID 1 Data 100 %R101 25 
Update Timeout 210mS Status n/a %R1001 n/a 

Node 3 – Consumption Node  
Exchange Number #1 Type Byte Offset Start Length 
Producer IP 192.168.0.1 Data 0 %R1 50 
Group Data ID 1 Data 100 %R101 25 
Update Timeout 210mS Status n/a %R1001 n/a 
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MULTICAST CONFIGURATION NODE 1 

To configure Node 1 for the EGD Example, perform the following steps: 
 
1. On the main Cscape screen, select New on the File menu to start a new user program. 
Then open the OCS configuration dialog by selecting the following in Cscape: Controller → 
Hardware Configuration (or select “I-O” button from the Menu bar), then select Device and 
Model number. Select EGD checkbox → Configure Selected Protocol.  

2. Once the Configure Selected Protocol button is selected, the Ethernet Global Data dialog 
is displayed. Two options are available: Produced Exchanges and Consumed Exchanges.  
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3. Select Add Exch to create a produced exchange, and then select Group ID and add 

appropriate group number. Click OK.  
 
 NOTE: To create Multicast communication, use Group ID and not IP Address.  
 

 

 

4. The Produced Exchange has been created. Select Exchange 1, then click on the Add Range 
button to define a Data Block for Produced Exchange 1. Then fill in the parameters and click 
OK. 
 

 
 
Continue adding the rest of the produced range details. 
   

Exchange #1: Produced Range Details 
Byte Offset Start Length 

0 %R1001 50 
100 %R1501 25 
150 %R1601 25 
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At this point, the Produced Exchanges tab in the EGD Configuration dialog should be as 
shown in the figure below.  

 

 

6. Node 1 configuration is now complete. Click OK, save the program using an appropriate 
filename such as EX_2 Node 1.csp, and then continue with Node 2 configuration.  
 
NOTE: This is a multicast. Node 1 will produce exchanges to GROUP 1 which in turn will send 

exchanges to all nodes that are assigned to Group 1. 
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MULTICAST EGD EXAMPLE – CONFIGURING NODE 2 

1. On the main Cscape screen, select New on the File menu to start a new user program. Then 
open the OCS configuration dialog by selecting the following in Cscape: Controller → 
Hardware Configuration (or select “I-O” button from the Menu bar), then select Device and 
Model number. Select EGD checkbox → Configure Selected Protocol. 

 
2. Once Exchange 1 has been configured as a Produced Exchange for Node 1, configure 

Exchange 1 as a Consumed Exchange for Node 2. To do this, first select the Consumed 
Exchanges tab and click on the Add Exch button to create a Consumed Exchange.  
 

 
 
Then fill in the parameters, as shown below, and click OK. 
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3. Once a Consumed Exchange has been made and highlighted, click on the Add Range 
button, in the EGD Configuration dialog, to define a Data Block for Consumed Exchange 1. 
Then fill in the parameters, as shown in below, and click OK. 

 

 
 

 
Continue adding the rest of the produced range details for Node 2. 
 

Exchange #1: Consumed Range Details 
Type Byte Offset Start Length 
Data 0 %R1 50 
Data 100 %R101 25 

Status n/a %R1001 n/a 
 
At this point, the Consumed Exchanges tab in the EGD Configuration dialog should be as 
shown in the figure below.   
 

 
 

4. Node 2 configuration is now complete. Click OK, save the program using an appropriate 
filename such as EX_2 Node 2.csp, and then continue with Node 3 configuration.  
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MULTICAST EGD EXAMPLE – CONFIGURING NODE 3 

 

1. On the main Cscape screen, select New on the File menu to start a new user program. Then 
open the OCS configuration dialog by selecting the following in Cscape: Controller → 
Hardware Configuration (or select “I-O” button from the Menu bar), then select Device and 
Model number. Select EGD checkbox → Configure Selected Protocol. 

 
  

Exchange #1: Consumed Range Details 
Type Byte Offset Start Length 
Data 0 %R1 50 
Data 150 %R101 25 

Status n/a %R1001 n/a 
 
 
At this point, the Consumed Exchanges tab in the EGD Configuration dialog should be as 
shown in the figure below.  

 
2. Repeat steps from Node 2. Open Then fill in the parameters, as shown below, and click OK. 
 

 
 
Then fill in the parameters, as shown below, and click OK. 
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3. Once a Consumed Exchange has been made and highlighted, click on the Add Range 
button, in the EGD Configuration dialog, to define a Data Block for Consumed Exchange 1. 
Then fill in the parameters, as shown in below, and click OK. 

 

 
 

 
 
4. Node 1 configuration is now complete. Click OK, save the program using an appropriate 
filename such as EX_2 Node 2.csp, and then continue with Node 3 configuration.  
 
 

EGD EXAMPLE 2  - STARTING MULTICAST EGD COMMUNICATION 

1.  Open the saved Node 1 user program (Node 1.csp) and download it to Node 1. 
2. Open the saved Node 2 user program (Node 2.csp) and download it to Node 2. 
3. Open the saved Node 3 user program (Node 3.csp) and download it to Node 3. 
 
Connect both Node 1, Node 2, and Node 3 to an Ethernet network and put them both in RUN 
mode.  
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CHAPTER 9: SERVICE REQUEST TRANSFER 
PROTOCOL (STRP) 
  

9.1 STRP Overview 
 
Service Request Transfer Protocol (SRTP) is a GE Fanuc Automation protocol, which allows a 
remote SRTP Client to request services from an SRTP Server. In this context, the OCS acts as 
an SRTP Server, which responds to requests from one or more SRTP Clients. 
 
Since SRTP was originally designed to support services provided by GE Fanuc Series 90 PLC 
products, the OCS’s SRTP protocol, for OCS and RCS products, does not support all possible 
SRTP services. The OCS’s implementation of SRTP is mainly limited to those services required 
for the exchange of PLC register data. 
 
The following SRTP service requests are supported by the OCS: 
 

Table 9.1 – SRTP Service Requests   
Request Code Service Name 

0 PLC_SSTAT 
1 PLC_LSTAT 
4 READ_SMEM 
7 WRITE_SMEM 

33 CHG_PRIV_LEVEL 
67 RET_CONFIG_INFO 
79 SESSION_CONTROL 
97 PLC_FEATURES_SUPP 

  
The READ_SMEM and WRITE_SMEM requests are supported for the following register types: 
 

Table 9.2 – SRTP Register Types 
Selector Register Type 

8 %R 16 bit 
10 %AI 16 bit 
12 %AQ 16 bit 
16 %I 8 bit 
18 %Q 8 bit 
20 %T 8 bit 
22 %M 8 bit 
30 %S 8 bit 
70 %I 1 bit 
72 %Q 1 bit 
74 %T 1 bit 
76 %M 1 bit 
84 %S 1 bit 
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9.2 STRP Configuration 
 

 
 
 
If SRTP protocol will be used in the application, the general OCS Configuration, previously 
described in Chapter 5, must be performed, and SRTP must be enabled. To enable SRTP 
protocol, use Cscape Programming Software, to perform the following two steps: 
 
1. Open OCS Wi-Fi LAN configuration dialog by selecting Controller → Hardware 

Configuration (select a series and device type)→ (OCS Wi-Fi Module) Config → General 
LAN config.  Then select SRTP Slave (90-30 Service Request) → Configure Selected 
Protocol.  

  
 
2. Enable SRTP by checking the SRTP Slave (90-30 Service Request) checkbox in the Module 

Configuration dialog, see below.  
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9.3 SRTP Operation 
 
With respect to SRTP protocol, the OCS’s behavior depends on whether the OCS is in RUN mode 
or not. 
 

• When the OCS is in RUN mode, the OCS responds normally to SRTP Client requests. 
 

• When the OCS is not in RUN mode, it still responds to SRTP Client requests, with the 
following differences: 
 
1. When a WRITE_SMEM request is received from an SRTP Client, to write a block 

of OCS registers, a reply is sent to the client, but the data is not written to OCS 
registers. 

 
2. When a READ_SMEM request is received from an SRTP Client, to read a block of 

OCS registers, a reply is sent to the client, but the data returned to the client is 
the last known values of the requested OCS registers, and is not actually read 
from the OCS registers. 

 
3. For all requests received from an SRTP Client, the reply will indicate to the client 

that the OCS is not in RUN mode, by returning the RUN DISABLED code in the 
Piggyback Status word. 
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CHAPTER 10: FTP SERVER PROTOCOL 
 

10.1 FTP Server Protocol Overview 
File Transfer Protocol (FTP) is a standard Client/Server Internet protocol, based on RFC959, 
which supports efficient and reliable file transfers over a TCP/IP network. In this context, the 
OCS acts as an FTP Server, which responds to file transfer requests from one or more FTP 
Clients. 
 
NOTE: FTP protocol is supported only by OCS Models, which have built-in Ethernet and an OCS 

file system with removable media (such as Compact Flash / microSD).  For OCS Models 
that do not have an OCS file system, the FTP (File Transfer) checkbox will be grayed out 
in Cscape’s Ethernet LAN1 Configuration dialog. 

 
The OCS’s FTP Server supports both anonymous and authenticated file transfers between an 
FTP Client and the OCS file system. Authenticated file transfers require that the FTP Client 
provide one of two possible Username and Password pairs, before the OCS file system can be 
accessed. 
 
Properly authenticated, an FTP Client can access OCS file system functions, which include file 
read, file create, file delete, file rename, file write, directory read, directory create, and directory 
delete. 
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10.2 FTP Configuration 
 
If FTP File Transfer will be used in the application, FTP Configuration must be performed, in 
addition to the general Ethernet LAN1 Configuration. To configure FTP protocol, use Cscape 
Programming Software to perform the following five steps: 
 
1. Open OCS Wi-Fi LAN configuration dialog by selecting Controller → Hardware 

Configuration (select a series and device type)→ (OCS Wi-Fi Module) Config → General 
LAN config.  Then select FTP (File Server) → Configure Selected Protocol.  

 

 
 

 
2. Enable FTP by checking the FTP (File Server) checkbox in the LAN1 Configuration dialog 

Until this is done, the OCS will not respond to any FTP Client requests. 
 
3. Click on the Configure Selected Protocol button next to the FTP (File Server) checkbox to 

open the FTP Configuration dialog. Refer to figure below.  
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4. Optionally, set up the FTP Configuration parameters for User 1 and/or User 2 as follows: 
 

Table 10.1 – FTP Configuration Parameters 
User Name Enter an alphanumeric string (up to 40 characters) for the FTP Client’s User 

Name 
Password Enter an alphanumeric string (up to 40 characters) for the FTP Client’s 

Password. 
Read Only Select this option to give the FTP Client read-only access to the OCS file 

system. 
Read / Write Select this option to give the FTP Client read-write access to the OCS file 

system. 
 
 

NOTE: User Names and Passwords are case-sensitive and, by default, User Name and 
Passwords for both User 1 and User 2 are empty. In this case, anonymous FTP Clients 
can access OCS files, but file access will be read-only. In a typical application, both 
User 1 and User 2 should be configured - one with read-only access and the other 
with read-write access.  

 
5. Click OK to accept the new FTP protocol configuration. 
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10.3 FTP Operation 
 
After performing OCS FTP Configuration, a 3rd party FTP Client (such as a PC running SmartFTP) 
can be used to access the OCS file system. 
 
The target OCS’s configured IP Address, FTP User Name (if any), and FTP Password (if any), 
must be entered into the FTP Client, to establish an FTP connection before any file accesses 
can be initiated. Please refer to documentation provided with the 3rd party FTP Client, regarding 
how to install, configure and operate the FTP Client. 
 
When configuring an FTP Client, the user should be aware that the FTP protocol standard 
defines many optional features. Like many UNIX implementations, the OCS FTP Server imposes 
constraints on some of these options, as shown in Table 10.2 below. 
 

Table 10.2 –FTP Server Option Constraints 
FTP Option Supported Not Supported 

File Transfer Type Binary Type ASCII Type & EBCDIC Type 
File Format Non-Print Format Telnet Format & Carriage Control Format 
File Structure File Structure Record Structure & Page Structure 
Transmission Mode Stream Mode Block Mode & Compressed Mode 
Data Connection Mode Active (PORT) Mode Passive (PASV) Mode 

 
In addition, since the FTP Server will automatically disconnect an FTP Client after about 3 
minutes of inactivity, the user might need to configure the FTP Client to periodically send NOOP 
(No Operation) commands to the FTP Server, to keep the connection alive. 
 

10.4 FTP File Accessing 
 
When using FTP to exchange files with an OCS, the user should know that the OCS file system 
implements an “8.3” filename format, which means all file and directory names should consist 
of up to 8 characters, followed by an optional dot, and an optional extension with up to 3 
characters. 
 
Also, the OCS file system allows multiple concurrent file accessing. For example, an FTP Client 
can read a file at the same time the OCS ladder program is logging data to another file. It is also 
possible for both the FTP Client and OCS ladder functions to read the same file at the same 
time. 
 
If there is a file access conflict, such as an FTP Client attempting to delete a file that is currently 
being read or written by ladder, the file delete request is denied and an error response is sent 
to the FTP Client. 
 

  



  MAN1234-03-EN_HE-WIFIUSB _UM 

D e c e m b e r  1 ,  2 0 2 0      P a g e  88 | 121 
 

CHAPTER 11: HTTP SERVER PROTOCOL 
 

11.1 HTTP Overview 
 
 
Hypertext Transfer Protocol (HTTP) is a standard Client/Server Internet protocol, based on 
RFC1945, which transfers web content over a TCP/IP network. In this context, the OCS acts as 
an HTTP Server (web content provider), which responds to requests from HTTP Clients (web 
browsers). 
 
The OCS’s HTTP Server supports optional HTTP Client authentication, requiring the web 
browser operator to enter a User Name and Password, before web content can be accessed. 
 
Properly authenticated, an HTTP Client can access web content previously stored in the OCS 
file system. This web content can include standard static HTML files and other web resource 
files. In addition, the HTTP Server allows the HTTP Client to display and edit OCS register data, 
by embedding specially named dynamic HTML files (readreg.htm and writereg.htm) into a static 
HTML file. 
 

11.2 HTTP Configuration 
If the HTTP Web Server will be used in the application, HTTP Configuration must be performed, 
in addition to the general Ethernet LAN Configuration. To configure HTTP protocol, use Cscape 
Programming Software to perform the following five steps: 
 
1. Open OCS Wi-Fi LAN configuration dialog by selecting Controller → Hardware 

Configuration (select a series and device type)→ (OCS Wi-Fi Module) Config → General 
LAN config.  Then select HTTP (Web Server) → Configure Selected Protocol.  

 

 
 
 

2. Enable HTTP by checking the HTTP (Web Server) checkbox in the LAN1 Configuration dialog 
Until this is done, the OCS will not respond to any HTTP Client requests. 

 
3. Click on the Configure Selected Protocol button next to the HTTP (Web Server) checkbox to 

open the HTTP Configuration dialog. Refer to figure below. 
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Optionally, set up the HTTP Configuration parameters for User 1 as follows: 
 

Table 11.1   HTTP Configuration Parameters  
User Name Enter an alphanumeric string (up to 40 characters) for the HTTP Client’s 

User Name 
Password Enter an alphanumeric string (up to 40 characters) for the HTTP Client’s 

Password. 
Read Only This option is always deselected and grayed out. 
Read / Write This option is always selected and grayed out. 

 
NOTE: User Names and Passwords are case sensitive, and, by default, the User Name and 

Password are empty. In this case, all HTTP Clients can access the OCS web content. In a 
typical application, the User Name and Password should be configured for security 
purposes. 

 
5. Click OK to accept the new HTTP protocol configuration. 
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11.3 HTTP Operation 
 
After performing HTTP Configuration, a 3rd party HTTP Client (such as a PC running Internet 
Explorer) can be used to browse OCS web content. 
 
To start browsing web resources stored in the OCS file system, enter the appropriate URL 
(Uniform Resource Locator) into the HTTP Client (web browser). As a minimum, the URL should 
include the target OCS’s IP Address and a filename. For example, if the OCS’s IP address is 
192.168.254.128, the following URL will access the index.htm file in the OCS file system root 
directory:  
 
 http://192.168.254.128/index.htm 
 
NOTE: The HTTP Server does not automatically default to index.htm, if no file is specified in the 

URL. 
 
If the OCS was configured with a User Name and Password, the browser will prompt for the User 
Name and Password to be entered, before opening the web page. Please refer to documentation 
provided with the 3rd party HTTP Client, regarding how to install, configure and operate the 
HTTP Client. 
 
The OCS HTTP Server implements HTTP/1.0 and does not support persistent connections. 
Therefore, each time a web page (or other resource) is transferred, the following sequence 
takes place: 
 

1. The HTTP Client (web browser) opens a connection with the HTTP Server and sends a 
request. 

2. The HTTP Server sends a response to the HTTP Client and then closes the connection. 
 
Since the connection only stays open long enough to complete one request, multiple HTTP 
Clients can concurrently access OCS web content, even though they are sharing a single 
connection. 

http://192.168.254.128/index.htm
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11.4 Web Content - Storing 
 
When storing web content files in the OCS file system, the user should know that the OCS file 
system implements an “8.3” filename format, which means all file and directory names must 
consist of up to 8 characters, followed by an optional dot, and an optional extension with up to 
3 characters. 
 
Web content files can be stored into the OCS file system media (such as Compact Flash / 
microSD), by temporarily plugging the media into a PC with an installed card reader, or via 
Ethernet using FTP (File Transfer Protocol). See Chapter 10 for information on using the OCS 
FTP Server. 
 
To keep the web content files organized, multiple files, directories and subdirectories can be 
created on the OCS file system media as desired. Normally, it is a good practice to store an 
index.htm file in the root directory as a “home page”, but this is not required. 
 
 

11.5 Web Content - Dynamic Data 
 
An OCS HTML file is either static or dynamic. The application engineer creates a static HTML 
file and stores it on the OCS file system media. Because of special markups in the static HTML 
file, the HTTP Server creates dynamic HTML files to access OCS Registers. This technique allows 
a static HTML file to read and write OCS registers dynamically. 
 
STATIC HTML FILES  
 
Custom HTML files are created to suit the application. These files can be created with a simple 
text editor or by using a 3rd party HTML Editor. 
 
Within the static HTML file, <iframe> and <form> tags respectively read and write OCS Register 
data, by referencing two specially named dynamic HTML files (readreg.htm and writereg.htm). 
 
 
DYNAMIC HTML FILES – READING OCS REGISTER DATA (READREG.HTM) 
 
OCS Register data is read by placing an <iframe> tag, that references readreg.htm, within a 
static HTML file. The following example <iframe> tag reads and displays OCS Register %R11 as 
an Unsigned Integer every two seconds: 
 

<iframe src="readreg.htm;reg–R11;fmt–UINT;rfs–2"></iframe> 
 
The required src attribute is a quoted string containing the readreg.htm reference and two or 
three parameters, all separated by semicolons. The reg, fmt and rfs parameters specify the OCS 
Register to read, the display format to use and optionally how often to refresh the data. These 
parameters are described in more detail in the following 3 sections: 
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REG PARAMETER – OCS REGISTER READ REFERENCE 
 
Examples: reg–R11 
  reg–R11.3 
The required reg parameter is followed by a dash and an OCS Register reference. Register 
reference numbers start at 1 and the maximum depends on the register type and OCS type, as 
show in the following table: 
 

Table 11.2 – OCS Register Read References  
OCS Register Type Maximum Reference (ETN200) Maximum Reference (ETN300) 

%R R2048 R9999 

%AI, %AQ AI512, AQ512 AI512, AQ512 
%I, %Q, %M, %T I2048, Q2048, M2048, T2048 I2048, Q2048, M2048, T2048 
%S S16 S16 

 
➢ For BOOL formatting (see next section), a bit number can be appended to 16-bit register 

references (%R, %AI and %AQ). For example, reg–R11.3 references bit 3 of register %R11. 
Valid bit numbers are 1 through 16. 

 
fmt Parameter – OCS Register Read Format 
 
Examples:  fmt–BOOL 
 fmt–BOOL–ON–OFF 
 fmt–BOOL–YES–NO 
 fmt–BIN 
 fmt–HEX 
 fmt–INT 
 fmt–UINT 
 fmt–DINT 
 fmt–UDINT 
 fmt–REAL 
 fmt–REAL–E 
 fmt–ASCII–10 
 fmt–IPADR 
 
The required fmt parameter is followed by a dash and a display format type. Valid format types 
are BOOL, BIN, HEX, INT, UINT, DINT, UDINT, REAL, ASCII and IPADR. Three of these format 
types (BOOL, REAL and ASCII) have optional or required modifiers as follows: 
 
The BOOL format reads and displays a single bit, and two optional modifiers indicate the text 
to display for the bit’s logical On and Off states. The text "TRUE" and "FALSE" will be displayed 
if the modifiers are omitted. In other words, fmt–BOOL is equivalent to fmt–BOOL–TRUE–FALSE. 
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The REAL format reads a 32-bit floating-point value, and the optional –E modifier can be used 
to display data in exponential (scientific) notation. The fmt–REAL format displays a variable 
number of digits to the left of the decimal point and 6 digits to the right of the decimal point 
(e.g. –12345.000000). On the other hand, the fmt–REAL–E format only shows 1 digit to the left 
of the decimal point and shows 6 digits to the right of the decimal point followed by a 4-
character power of 10 (e.g. –1.234500E+04). 
 
The ASCII format accesses a string of ASCII characters, and a string size modifier from –1 to –31 
is required, indicating how many ASCII characters to read and display. For example, the fmt–
ASCII–10 format reads and displays a string of 10 ASCII characters. 
 
 
 
rfs Parameter – OCS Register Read Auto-Refresh 
 
Example: rfs–2 
 
The optional rfs parameter specifies how often the <iframe> should automatically refresh the 
data on the browser screen. For example, rfs–2 will cause the data to be refreshed every 2 
seconds. 
 
The number of seconds specified can range from 0 to the limits of the browser. A refresh time 
of 0 will refresh the data as often as possible, but this is not recommended because of the 
volume of Ethernet traffic it can create. If the optional rfs parameter is omitted, the data will 
only be refreshed when the user manually refreshes their web browser screen. 
 
The rfs parameter uses a technique called “client-pull” to tell the web browser to do the periodic 
refresh. Not all web browsers support “client pull” and those that do support it can usually be 
configured to disable it for security purposes. 
   
NOTE: When using an Internet Explorer browser to view OCS web pages that employ the rfs 

parameter, the browser plays the currently configured Start Navigation sound (a short 
“tick” by default) for each refresh. To disable the “ticking”, (1) open the Windows Control 
Panel, (2) click the Sounds or Sound and Audio Devices icon or link and (3) turn off the 
Start Navigation sound by selecting (None) for it in the drop-down list. 
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fnt Parameter – OCS Register Read Font 
 
Example: fnt-5-arial-blue 
 
The optional fnt parameter specifies the font size, typeface and color to be used when OCS 
Register data is displayed on the browser screen. 
 
All 3 font attributes (size, typeface and color) are optional, but must be specified in the order 
shown. For example, fnt-5-arial specifies a size 5, Arial font, but will use the browser’s default 
text color. 
 
If the size or typeface is omitted, its dash character should still be used as a placeholder. For 
example, fnt---blue specifies that the displayed text will be blue, but the browser’s default font 
size and typeface will be used.  
 
NOTE: In this last example, there are 3 dashes between fnt and blue. 
 
For the 1st attribute (font size), a number from 1 to 7 can be used, with 1 as the smallest and 7 as 
the largest. This is a browser limitation, as browsers typically support only 7 font sizes. 
Optionally, a point size can be specified, such as 12pt, but the browser will translate this into 
one of its supported font sizes. 
 
For the 2nd attribute (font typeface), any typeface name supported by the browser can be used, 
such as Arial, Times New Roman or Courier New.  
 
For the 3rd attribute (font color), the 16 standard HTML color names should always work. These 
16 standard colors are aqua, black, blue, fuchsia, gray, green, lime, maroon, navy, olive, purple, 
red, silver, teal, white and yellow.  
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Dynamic Html Files – Writing OCS Register Data (writereg.htm) 
 
OCS Register data is written by placing a <form> tag, that references writereg.htm, within a 
static HTML file. The following example <form> tag sets up an Unsigned Integer write to OCS 
Register %R11: 
 

<form action="writereg.htm;reg–R11;fmt–UINT" method="post">…</form> 
 
Between the <form> and </form> tags, there should be one or more <input> tags that enable a 
browser operator to enter or select data and write it to the register. 
 
For example, in the following complete <form> markup, the first <input> tag creates a text input 
box, containing a default value of 0, which allows the user to enter a new value for %R11. The 
second <input> tag creates a Send button, which can be clicked to submit the new value (write 
it to the register):  
 
            <form action="writereg.htm;reg–R11;fmt–UINT" method="post"> 

<input type="text" name="reg" value="0"> 
<input type="submit" value="Send"> 

 </form> 
 
In the following example, the first <input> tag creates an ON button that can be clicked to turn 
%T22 On, while the second <input> tag creates an OFF button that can be clicked to turn %T22 
Off. 
 
            <form action="writereg.htm;reg-T22;fmt-BOOL-ON-OFF" method="post"> 

<input type="submit" name=”reg” value="ON"> 
<input type="submit" name=”reg” value="OFF"> 

 </form> 
 
Important: In the above two examples, the OCS HTTP Server expects the name=”reg” 

attributes to appear exactly as shown. 
 
The <form> tag’s required action attribute is a quoted string containing the writereg.htm 
reference and two parameters, all separated by semicolons. The reg and fmt parameters specify 
the OCS Register to write and the data entry/select format to use. These parameters are 
described in more detail in the following 2 sections: 
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reg Parameter – OCS Register Write Reference 
 
Examples: reg–R11 
  reg–R11.3 
 
The required reg parameter is followed by a dash and an OCS Register reference. Register 
references start at 1 and the maximum reference depends on the register type and OCS type, 
as show in the following table: 
 

Table 11.3 – OCS Register Write References 
OCS Register Type Maximum Reference (ETN200) Maximum Reference 

(ETN300) 
%R R2048 R9999 

%AI, %AQ AI512, AQ512 AI512, AQ512 
%I, %Q, %M, %T I2048, Q2048, M2048, T2048 I2048, Q2048, M2048, 

T2048 
 
➢ For BOOL formatting (see next section), a bit number can be appended to 16-bit register 

references (%R, %AI and %AQ). For example, reg-R11.3 references bit 3 of register %R11. 
Valid bit numbers are 1 through 16. 
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fmt Parameter – OCS Register Write Format 
 
Examples:  fmt–BOOL 
 fmt–BOOL–ON–OFF 
 fmt–BOOL–YES–NO 
 fmt–BIN 
 fmt–HEX 
 fmt–INT 
 fmt–UINT 
 fmt–DINT 
 fmt–UDINT 
 fmt–REAL 
 fmt–ASCII–10 
 
The required fmt parameter is followed by a dash and a data entry format type. Valid format 
types are BOOL, BIN, HEX, INT, UINT, DINT, UDINT, REAL and ASCII. Three of these format types 
(BOOL, REAL and ASCII) have optional or required modifiers as follows: 
 
The BOOL format writes a single bit, and two optional modifiers indicate the text that must be 
submitted to set the bit to its logical On and Off states. If these modifiers are omitted, they 
default to “TRUE” and “FALSE”, so that fmt–BOOL is equivalent to fmt–BOOL–TRUE–FALSE.   
 
The REAL format writes a 32-bit floating-point value, and data can be entered in either standard 
decimal notation or in scientific notation as desired, with or without the –E modifier. The –E 
modifier is not necessary and is ignored if present. 
 
The ASCII format accesses a string of ASCII characters, and a string size modifier from –1 to –31 
is required, indicating how many ASCII characters will be written when the form is submitted. 
For example, the fmt–ASCII–10 format writes a string of 10 ASCII characters. If the user enters 
an ASCII string that is smaller than the specified string size, the submitted string will be padded 
with spaces. 
 
 

11.6 Web Content - Authoring 
 
Web content can range from very simple to extremely complex depending on application needs. 
As such, it is well beyond the scope of this supplement to attempt to provide a tutorial on the 
subject. 
 
Web Server Example Applications  
 
One of the best ways to learn how to use the HTTP Web Server is to study working examples. 
OCS HTTP Web Server Examples are available for download on the Horner Automation 
website (Support → HE-XEC Ethernet Utility → OCS Web Demo.)  
 

https://hornerautomation.com/support-files/ 
 

https://hornerautomation.com/support-files/


  MAN1234-03-EN_HE-WIFIUSB _UM 

D e c e m b e r  1 ,  2 0 2 0      P a g e  98 | 121 
 

Web Authoring Tools  
 
 
There are several 3rd party tools available to assist in the development of web content. These 
tools come in four basic types: Text Editors, HTML Editors, WYSIWYG Programs, and Word 
Processors. 
 
Text Editors require a thorough knowledge of HTML (HyperText Markup Language). However, 
many experienced web developers prefer to work using a plain text editor. 
 
HTML Editors are specially enhanced text editors designed specifically to make web page 
creation easier, but they still require a great deal of HTML knowledge. 
 
WYSIWYG (What You See Is What You Get) Programs allow HTML code creation using drag and 
drop techniques, and thus promise to minimize the author’s need to understand HTML. 
However, when problems arise, there is no substitute for getting into the generated HTML code 
to see what is going on. 
 
Word Processors should be avoided for web content design because they are not designed for 
this purpose.  
 
 

Table 11.4 – Web Content Authoring Tools 
Tool Name Tool Type Platform(s) Web Site 

Homesite 
HTML 
Editor 

Windows 
 

http://www.adobe.com/ 
 

Dreamweaver 
WYSIWYG 
Program 

Windows 
MAC 

 
http://www.adobe.com/ 

 
 
  

http://www.adobe.com/
http://www.adobe.com/
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CHAPTER 12: ASCII over TCP/IP 
 

12.1 Overview 
 
This protocol is designed to send and receive ASCII data over Ethernet port of the controllers. 
Controller acts as a server while using this protocol. 

Minimum version requirements for ASCII over TCP/IP feature: 

- Firmware 12.6 or later  

- Cscape 9 or later 
 

12.2 ASCII Configuration 
 

1. Open OCS Wi-Fi LAN configuration dialog by selecting Controller → Hardware 
Configuration (select a series and device type)→ (OCS Wi-Fi Module) Config → General LAN 
config.  Then select ASCII Over TCP/IP  → Configure Selected Protocol.  
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2. In ASCII over TCP/IP Configuration window configure Port Number, register for start 
address of Transmit data, register for start address for Receive data, Transmission Trigger 
Register and Status Address. 
 
Port Number can be provided directly or by using register address. For port number entry 
using register user has to select Get from Register option. 
 

 
   

 

12.3 Sending ASCII characters to the client 
 
In above configuration dialog %R800 and %R100 registers are configured for sending data. 
 
%R800 is start of transmit data and should contain data in following format. 
 

Table 12.1 - %R800 Register and Data 
Sl.No Register Address Data Content 
1 %R800 First Register should contain ‘Transmit Count’ i.e. number 

of bytes (characters) to be transmitted. 
2 %R801 Reserved. 
3 %R802 Data to be transmitted. Each Register can hold 2 bytes of 

data. 
4 %R803 Data to be transmitted. 
 .. Data to be transmitted. 
 .. Data to be transmitted. 
n %R(800+n-1) Data to be transmitted. 

 
NOTE: Maximum 2K ASCII characters can be sent in a single request. 
 
%R100 is Transmit Trigger register used to start the transmission process. Setting R100 data 
to ‘1’ will initiate transmission process and on successful transmission firmware will reset the 
R100 data to ‘0’. 
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12.4 Receiving ASCII Characters from the Client 
 
In above configuration dialog %R500 register is used for receiving data. The receive data 
register format will be as below. 
 

Table 12.2 - %R500 Register and Data 
Sl.No Register Address Data Content 
1 %R500 First Register contains number of byes (characters) 

received. 
2 %R501 User can provide valid termination character here (if any). 

If there is no termination character set this register value 
to zero.  

3 %R502 Received data. Each Register can hold 2 bytes of data. 
4 %R503 Received data. 
 .. Received data. 
 .. Received data. 
n %R(500+n-1) Received data. 

 
NOTE: Maximum 2K ASCII characters can be received in a single request. 
 
 

12.5 Status Information 
 
%R700 register is used for to display status information. Details of Status Register as below. 
 

Table 12.3 - %R700 Register and Data 
Bit No. Description 
1 Receive Data Overflow: Set when number received characters are more than 

255. 
2 Transmit Data Overflow: Set when transmit character count is more than 255. 
3 Socket Creation Error: Set if there is any error in Socket creation. 
4 Socket Allocate Error: Set if there is any internal memory allocation error for 

transmitting data. 
5 Socket Send Error: If error in transmitting TCP packet. 
6 Reserved 
7 Reserved 
8 Reserved 
9 Reserved 
10 Reserved 
11 Reserved 
12 Reserved 
13 Reserved 
14 Reserved 
15 Reserved 
16 Receive Data indication Bit: Set when new packet is received. User can reset 

this bit to ‘0’. 
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CHAPTER 13: DOWNLOADABLE PROTOCOLS 
(ETHERNET) 
 

13.1 Modbus Overview 
 
MODBUS TCP/IP is a variant of the MODBUS family of simple, vendor-neutral communication 
protocols. It is intended for supervision and control of automation equipment. Specifically, it 
covers the use of MODBUS messaging in an ‘Intranet’ or ‘Internet’ environment using the 
TCP/IP protocols. The most common use of this protocol is for Ethernet attachment of PLC’s, 
I/O modules, and ‘gateways’ to other simple field buses or I/O networks. 
 
Modbus TCP is a Client / Server protocol, which allows a remote Modbus TCP Client to request 
services from a Modbus TCP Server. In this context, the OCS acts as a Modbus TCP Server, 
which responds to requests from one or more Modbus Clients. 
 
All Modbus requests that contain the OCS’s IP Address are serviced. The client needs to be 
configured with the OCS’s IP Address, and most clients also require the server unit number. 
Since each Ethernet module must have its own unique IP Address, the server unit number is not 
relevant and is discarded by the Ethernet module. 
 
To access OCS registers, a Modbus TCP Client must be configured with the appropriate register 
type and offset. This is usually accomplished with one of two methods: 
 
The first method uses either Traditional Modbus References or Expanded Modbus References, 
in which the high digit represents the register type and the lower digits represent the register 
offset (starting with register 1 for each type). Since only four Modbus register types (0, 1, 3, and 
4) can be represented in this manner, the OCS’s Modbus implementation packs several OCS 
register types into each Modbus register type. Starting addresses of each OCS register type are 
shown in the Traditional Modbus Reference and Expanded Modbus Reference columns. 
 
The second method requires the Modbus TCP Client to be configured with a specific Modbus 
Command and Offset. The supported Modbus commands and the associated offsets are also 
illustrated in the tables below.   
 
NOTE: Each controller family has its own Modbus Mapping table.   
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XLE/XLEe Series – Modbus Mapping 

OCS Ref. Max. 
Range 

Trad. Modbus 
Ref. 

(5 digits) 

Expanded 
Modbus Ref. 

(6 digits) 

Modbus Command(s) Modbus 
Offset 

%I1 2048 10001 010001  
Read Input Status (2) 

0 
%IG1 64 13001 013001 3000 
%S1 13 14001 014001 4000 
%K1 10 15001 015001 5000 

 
%Q1 2048 00001 000001 Read Coil Status (1)                        

Force Coil (5)                       
Force Multiple Coils (15) 

0 
%M1 2048 03001 003001 3000 
%T1 2048 06001 006001 6000 
%QG1 64 09001 009001 9000 

 
%A1 512 30001 030001 Read Input Register (4) 0 
%AIG1 32 33001 033001 3000 
%SR1 192 34001 034001 4000 

 
%AQ1 512 40001 040001 Read Holding Registers (3) 

Load Register (6)                 
Load Multiple Registers 
(16) 

0 
%R1 2488 40513 040513 0 
%R1 2048 43001 043001 3000 
%AQG1 32 46001 046001 6000 
%R1 9999 -- 410001 10000 

 
 

XLT/XLTe Series – Modbus Mapping 

OCS Ref. Max. 
Range 

Trad. Modbus 
Ref. 

(5 digits) 

Expanded 
Modbus Ref. 

(6 digit) 

Modbus Command(s) Modbus 
Offset 

%I1 2048 10001 010001  
Read Input Status (2) 

0 
%IG1 64 13001 013001 3000 
%S1 13 14001 014001 4000 
%K1 4 15001 015001 5000 

 
%Q1 2048 00001 000001 Read Coil Status (1)                        

Force Coil (5)                       
Force Multiple Coils (15) 

0 
%M1 2048 03001 003001 3000 
%T1 2048 06001 006001 6000 
%QG1 64 09001 009001 9000 

 
%A1 512 30001 030001 Read Input Register (4) 0 
%AIG1 32 33001 033001 3000 
%SR1 192 34001 034001 4000 

 
%AQ1 512 40001 040001 Read Holding Registers (3) 

Load Register (6)                 
Load Multiple Registers 
(16) 

0 
%R1 2488 40513 040513 0 
%R1 2048 43001 043001 3000 
%AQG1 32 46001 046001 6000 
%R1 9999 -- 410001 10000 
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XL4 Series – Modbus Mapping 

OCS Ref. Max. 
Range 

Trad. Modbus 
Ref. (5 digits) 

Expanded 
Modbus Ref. 

(6 digits) 

Modbus Command(s) Modbus 
Offset 

%I1 2048 10001 010001  
Read Input Status (2) 

0 
%IG1 256 13001 013001 3000 
%S1 256 14001 014001 4000 
%K1 4 15001 015001 5000 

 
%Q1 2048 00001 000001 Read Coil Status (1)                        

Force Coil (5)                       
Force Multiple Coils (15) 

0 
%M1 2048 03001 003001 3000 
%T1 2048 06001 006001 6000 
%QG1 256 09001 009001 9000 

 
%A1 512 30001 030001 Read Input Register (4) 0 
%AIG1 32 33001 033001 3000 
%SR1 256 34001 034001 4000 

 
%AQ1 512 40001 040001 Read Holding Registers (3) 

Load Register (6)                 
Load Multiple Registers 
(16) 

0 
%R1 2488 40513 040513 0 
%R1 2048 43001 043001 3000 
%AQG1 32 46001 046001 6000 
%R1 9999 -- 410001 10000 

 
 
 

XL+, XL7 & EXL6 – Modbus Mapping 

OCS Ref. Max. 
Range 

Trad. Modbus 
Ref. 

(5 digits) 

Expanded 
Modbus Ref. 

(6 digits) 

Modbus Command(s) Modbus 
Offset 

%I1 2048 10001 010001  
Read Input Status (2) 

0 
%IG1 256 13001 013001 3000 
%S1 256 14001 014001 4000 
%K1 5 15001 015001 5000 

 
%Q1 2048 00001 000001 Read Coil Status (1)                        

Force Coil (5)                       
Force Multiple Coils (15) 

0 
%M1 2048 03001 003001 3000 
%T1 2048 06001 006001 6000 
%QG1 256 09001 009001 9000 

 
%A1 512 30001 030001 Read Input Register (4) 0 
%AIG1 32 33001 033001 3000 
%SR1 256 34001 034001 4000 

 
%AQ1 512 40001 040001 Read Holding Registers (3) 

Load Register (6)                 
Load Multiple Registers 
(16) 

0 
%R1 2488 40513 040513 0 
%R1 2048 43001 043001 3000 
%AQG1 32 46001 046001 6000 
%R1 9999 -- 410001 10000 
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EXL10 – Modbus Mapping 

OCS Ref. Max. 
Range 

Trad. Modbus 
Ref. 

(5 digits) 

Expanded 
Modbus Ref. 

(6 digits) 

Modbus Command(s) Modbus 
Offset 

%I1 2048 10001 010001  
Read Input Status (2) 

0 
%IG1 256 13001 013001 3000 
%S1 256 14001 014001 4000 
%K1 7 15001 015001 5000 

 
%Q1 2048 00001 000001 Read Coil Status (1)                        

Force Coil (5)                       
Force Multiple Coils (15) 

0 
%M1 2048 03001 003001 3000 
%T1 2048 06001 006001 6000 
%QG1 256 09001 009001 9000 

 
%A1 512 30001 030001 Read Input Register (4) 0 
%AIG1 32 33001 033001 3000 
%SR1 256 34001 034001 4000 

 
%AQ1 512 40001 040001 Read Holding Registers (3) 

Load Register (6)                 
Load Multiple Registers 
(16) 

0 
%R1 2488 40513 040513 0 
%R1 2048 43001 043001 3000 
%AQG1 32 46001 046001 6000 
%R1 9999 -- 410001 10000 

 
 
 

X5 Series – Modbus Mapping 

OCS Ref. Max. 
Range 

Trad. Modbus 
Ref. (5 digits) 

Expanded 
Modbus Ref. 

(6 digits) 

Modbus Command(s) Modbus 
Offset 

%I1 2048 10001 010001  
Read Input Status (2) 

0 
%IG1 256 13001 013001 3000 
%S1 256 14001 014001 4000 
%K1 4 15001 015001 5000 

 
%Q1 2048 00001 000001 Read Coil Status (1)                        

Force Coil (5)                       
Force Multiple Coils (15) 

0 
%M1 2048 03001 003001 3000 
%T1 2048 06001 006001 6000 
%QG1 256 09001 009001 9000 

 
%A1 512 30001 030001 Read Input Register (4) 0 
%AIG1 32 33001 033001 3000 
%SR1 256 34001 034001 4000 

 
%AQ1 512 40001 040001 Read Holding Registers (3) 

Load Register (6)                 
Load Multiple Registers 
(16) 

0 
%R1 2488 40513 040513 0 
%R1 2048 43001 043001 3000 
%AQG1 32 46001 046001 6000 
%R1 8192 -- 410001 10000 
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X4 & X7 – Modbus Mapping 

OCS Ref. Max. 
Range 

Trad. Modbus 
Ref. 

(5 digits) 

Expanded 
Modbus Ref. 

(6 digits) 

Modbus Command(s) Modbus 
Offset 

%I1 1024 10001 010001  
Read Input Status (2) 

0 
%IG1 256 13001 013001 3000 
%S1 256 14001 014001 4000 
%K1 10 15001 015001 5000 

 
%Q1 1024 00001 000001 Read Coil Status (1)                        

Force Coil (5)                       
Force Multiple Coils (15) 

0 
%M1 1024 03001 003001 3000 
%T1 1024 06001 006001 6000 
%QG1 256 09001 009001 9000 

 
%A1 256 30001 030001 Read Input Register (4) 0 
%AIG1 32 33001 033001 3000 
%SR1 200 34001 034001 4000 

 
%AQ1 256 40001 040001 Read Holding Registers (3) 

Load Register (6)                 
Load Multiple Registers 
(16) 

0 
%R1 2488 40513 040513 0 
%R1 2048 43001 043001 3000 
%AQG1 32 46001 046001 6000 
%R1 5000 -- 410001 10000 

 
 
 

RCC Series – Modbus Mapping  

OCS Ref. Max. 
Range 

Trad. Modbus 
Ref. (5 digits) 

Expanded 
Modbus Ref. 

(6 digits) 

Modbus Command(s) Modbus 
Offset 

%I1 2048 10001 010001  
Read Input Status (2) 

0 
%IG1 64 13001 013001 3000 
%S1 13 14001 014001 4000 
%K1 0 15001 015001 5000 

 
%Q1 2048 00001 000001 Read Coil Status (1)                        

Force Coil (5)                       
Force Multiple Coils (15) 

0 
%M1 2048 03001 003001 3000 
%T1 2048 06001 006001 6000 
%QG1 64 09001 009001 9000 

 
%A1 512 30001 030001 Read Input Register (4) 0 
%AIG1 32 33001 033001 3000 
%SR1 200 34001 034001 4000 

 
%AQ1 512 40001 040001 Read Holding Registers (3) 

Load Register (6)                 
Load Multiple Registers 
(16) 

0 
%R1 2488 40513 040513 0 
%R1 2048 43001 043001 3000 
%AQG1 32 46001 046001 6000 
%R1 4096 -- 410001 10000 

 



  MAN1234-03-EN_HE-WIFIUSB _UM 

D e c e m b e r  1 ,  2 0 2 0      P a g e  107 | 121 
 

13.2 Modbus Client 
 
Select Modbus Client from the Ethernet drop-down list. Then click on the Network button. This 
will open the Network Config (Modbus Client) dialog.   
 

 

 

13.3 Network Config 
 

Network parameters and status registers can be configured in the Network Config 
dialog.   

• Configure minimum and maximum value for port ID’s as 1024 and 4096 
respectively. 

• Configure the update Scan type as automatic or manual according to process 
requirements.  

• Configure the (optional) network status register.  
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13.4 Device Config 
 
Click on Devices button to configure Server device (max 64) as follows: 
 

 
 
Add a device:  
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Enter Information to add a device then select OK.  Pleaes note the checked boxes below: 
 

 
 

• Configure server device name, IP address (either direct or through registers) and port 
ID (either direct or through registers). Configuring IP address or port ID through 
registers allows user to modify IP address or port ID during runtime. 
  
NOTE: User should change the controller mode to Idle and then to Run after modifying 

port ID during runtime.  
 

• Select the address mode required when talking to this device.  
• If option for Swap Words on 32-bit Data is checked, the high and low 16-bit values of 

32-bit Data are swapped when transferred between the target and OCS.  
• Device status registers can be optionally enabled and used to determine the current 

state of communications.  
• Select Stop on Error as per process requirement (located in the Status box at the 

bottom).  
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Device Type:  Modbus TcpIpClient.Dll supports the following addressing modes: 
 

• Generic Decimal Addressing 
• Generic Hexadecimal Addressing 
• Native Addressing 
• Modicon PLC 5-Digit Addressing 
• Modicon PLC 6-Digit Addressing 
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Generic Decimal Addressing    
 
The first option is Generic Decimal Addressing. Use this when the connected device uses an 
addressing mode which does not correspond to a Modicon PLC, and offsets in the 
documentation for the target device are given in decimal.  
 

 
 
Addresses are entered in the following form: 
 
<Data Type> <Decimal number> 

  
Data type takes one of the following values: 
RWR : (Read/Write Registers) Uses Modbus function codes 3, 6, 16 
RWB : (Read/Write Bits) Uses Modbus function codes 1, 5, 15 
ROR : (Read Only Registers) Uses Modbus function code 4 
ROB : (Read Only Bits) Uses Modbus function code 2 

  
The decimal number gives the offset of the target data in the selected data type. 
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Generic Hexadecimal Addressing 
 
Use this when the connected device uses an addressing mode which does not correspond to a 
modicon PLC, and offsets in the documentation for the target device are given in hexadecimal   
 

 
 

Addresses are entering the in the following form: 
 
<Data Type> <Decimal number> 

  
Data type takes one of the following values 

  
RWR : (Read/Write Registers) Uses Modbus function codes 3, 6, 16 
RWB : (Read/Write Bits) Uses Modbus function codes 1, 5, 15 
ROR : (Read Only Registers) Uses Modbus function code 4 
ROB : (Read Only Bits) Uses Modbus function code 2 

  
The hexadecimal number gives the offset of the target data in the selected data type. 
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Native Addressing 
 
Use this when the connected device is an OCS unit running Modbus TCP / IP host.  
 

 
 
Addresses are entered as standard OCS addresses.  
 
 
Modicon PLC 5-Digit Addressing 
 
Use this when the connected device uses an addressing mode which corresponds to a reduced 
memory map modicon PLC. 
 
 
Modicon PLC 6-Digit Addressing 
 
Use this when the connected device uses an addressing mod which corresponds to an 
extended memory map modicon PLC. 
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13.5 Scan List 
 
 

 
 
Click on Scan List button to open the Scan List (Modbus Client) dialog.  
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• To transfer data between the OCS and remote target, a Scan List must be created that 
defines each transaction. Each mapping entry (transaction) contains the source and 
destination registers, the number of consecutive registers transferred, the direction of 
the transfer and trigger for transfer (optional). Maximum number of entries is 512. 
 
NOTE: Order of the Scan List is the order in which the transaction occurs. 
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• Scan list for a client device is developed in the following steps:  
 
Click ADD button to open the Data Mapping dialog for adding new entry to the Scan 
List.   
 
Configure the following: 
 

Table 13.1 – Data Mapping Fields  
Device Name Select the target device from the drop-down list. 

Only those device entries previously created from 
the Device Config menu are available.  

Device Register Specify the target device’s register to be mapped 
according to the selected addressing mode.  

32-Bit Access Allows two local (OCS) 16-bit registers to be treated 
as a single 32-bit value. For example, if the value in 
either 16-bit register is modified, both registers are 
written to the device.  

Length Specify the number of consecutive device registers 
to Read/Write. Maximum length is 32.  

Local Register Specify the local (OCS) register that is the source or 
destination for transfer of the data. 

Local Name (Optional) Enter/Select name for the Local Register. 
Update Type This field specifies the direction and triggers the 

transfer of data between the OCS and target device. 
Select Update Type as per the system requirements. 

 
    

 



  MAN1234-03-EN_HE-WIFIUSB _UM 

D e c e m b e r  1 ,  2 0 2 0      P a g e  117 | 121 
 

 CHAPTER 14: SAFETY & WARNINGS 
 

14.1 Warnings 
 

1. Only qualified electrical personnel familiar with the construction and operation of this 
equipment and the hazards involved should install, adjust, operate, or service this 
equipment.  

2. Read and understand this manual and other applicable manuals in their entirety before 
proceeding.  

3. Failure to observe this precaution could result in severe bodily injury or loss of life.  
4. This module uses industry standard security and data integrity systems; however, care 

must be taken with any wireless system. Reviews on security and data integrity must 
be performed and appropriate mitigations must be put in place. Use of this or any 
wireless module for critical data or operation is not recommended.   

 

14.2 FCC Compliance 
 
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: 
 

1. This device may not cause harmful interference 
2. This device must accept any interference received, including interference that may 

cause undesired operation. 
 

14.3 Precautions 
All applicable codes and standards need to be followed in the installation of this product. 
Adhere to the following safety precautions whenever any type of connection is made to the 
module: 
1. Connect the safety (earth) ground on the power connector first before making any other     
connections. 
2. When connecting to the electric circuits or pulse-initiating equipment, open their related 
breakers. 
3.  Do NOT make connection to live power lines. 
4.  Make connections to the module first; then connect to the circuit to be monitored.  
5.  Route power wires in a safe manner in accordance with good practice and local codes. 
6. Wear proper personal protective equipment including safety glasses and insulated gloves 
when making connections to power circuits. 
7. Ensure hands, shoes, and floor are dry before making any connection to a power line. 
8. Make sure the unit is turned OFF before making connection to terminals. 
9. Make sure all circuits are de-energized before making connections.  
10. Before each use, inspect all cables for breaks or cracks in the insulation. Replace  
immediately if defective. 
11. Use copper conductors in Field Wiring only, 60/75˚C.  
12.  This adapter has been primarily tested without USB extensions.  USB extensions that 
follow the USB 2.0 or later standard will function properly.  If extending the USB connection is 
required, a quality cable is required along with a performance test in the application.   
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CHAPTER 15: TECHNICAL SUPPORT 
 

15.1 Technical Support Contacts 
 
For manual updates and assistance, contact Technical Support at the following locations: 
 
North America:  
Tel: (317) 916-4274 
Fax: (317) 639-4279 
Website: https://hornerautomation.com 
Email: techsppt@heapg.com 
 
Europe:  
Tel: (+) 353-21-4321-266 
Fax: (+353)-21-4321826 
Website: www.hornerautomation.eu 
Email: technical.support@horner-apg.com 
  

https://hornerautomation.com/
mailto:techsppt@heapg.com
http://www.hornerautomation.eu/
mailto:technical.support@horner-apg.com
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CHANGE LOG 
 

  

Change Log 
Date Rev # Description of Revision Location in Doc 

4/13/2020 2 Added USB precaution about USB extensions 
(Mantis #3078).   

Precautions 

12/1/2020 3 Update Drawings and dimensions (Mantis 
#4554) 

Dimensions 
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